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Personnel and Equipment Safety Information
This section describes important safety information to avoid personal injury and damage to the 
equipment while establishing communication with the analyzer. The following Warnings also 
describe safety measures to follow while communicating with the analyzer to review or modify 
Calibration and/or Configuration parameters, or while performing maintenance on or trouble-
shooting the analyzer. All safety regulations, standards, and procedures at the analyzer location 
must be followed.

All personnel involved with the installation, start-up, operation, maintenance, service, or trou-
bleshooting of the analyzer must review and follow these Warnings and Cautions.

Refer also to the analyzer manual for complete safety details on working with the analyzer.

Warnings
Review and follow these Warnings to avoid personal injury or environmental contamination.

Always disconnect main AC power and/or external power sources to the analyzer before open-
ing any covers or doors on the analyzer to check or perform maintenance on any components 
within the enclosures. 
 
If it is necessary to open the analyzer’s covers or doors while the circuits are live, test the area 
for flammable gases (and proceed only when the area is safe). 
 
Purged Analyzer (Hazardous Location) Applications 
To work on the analyzer with it powered up and its Electronics Enclosure door open, the Purge 
Bypass Switch must be in the “BYPASS” position. 
 
When the Electronics Enclosure door is open, take appropriate precautions to avoid electrical 
shock. Hazardous voltages are present inside.

Follow appropriate regulatory and/or company procedures to lock out the analyzer while work-
ing on its electronics.

Purged Analyzer (Hazardous Location) Applications 
[Special Conditions for Safe Use] 
The analyzer may only be energized by using the Purge Bypass Switch with permission of 
the works manager or his proxy. The permission may only be given when it is made sure that 
during the time the system is energized by using this switch an explosive atmosphere is not 
present or when the necessary protective measures against explosion hazard have been taken 
(“hot permit”). 
 
The analyzer enclosure may not be opened when an explosive atmosphere is present.

!
WARNING

!
WARNING

!
WARNING
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OVERVIEW

The primary use of AMETEK’s System 200 Configurator Software is to 
configure the analyzer’s operating parameters, control the analyzer func-
tions, view real-time and historical data, and modify configuration and 
calibration parameters. The software can also be used to perform mainte-
nance and troubleshoot the analyzer. The majority of these functions are 
performed from the M9XX Properties dialog box. Details of these tasks 
are described in Chapters 1–4.

The software also provides advanced software features, such as graphing 
and scanning data. Details of how to perform these tasks are described, 
primarily, in Chapters 5–11.

Familiarize yourself with the software operations (see Chapter 4) before 
using the software to work on the analyzer.

Hazardous Locations 
Before working with the software, test the area around the analyzer 
for explosive gases and proceed only when the area is found to be safe. 
 
Do not connect the computer to the analyzer’s serial communication 
port and do not power up the computer if there is an explosive gas 
atmosphere present.

!
WARNING
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About This User’s Guide

This guide describes the communication functions for the following 
AMETEK analyzers:

•	 Model 900 and 930 Analyzers

•	 Model 909 and 919 Analyzers

•	 Model 910 and 920 Analyzers

Information that is greyed out on certain screens is not applicable to the 
analyzer you are currently working with, or must be enabled by enter-
ing CALibration and ConFiGuration passwords in the Info (Analyzer 
Information) dialog box.

IMPORTANT 
References to “M9XX” or “9xx” in this guide refer to analyzer Models 
900, 909, 910, 919, 920, and 930, except if noted. In the software, 
the model reference is specific to the analyzer you are working with 
(i.e., M900). 
 
The Configurator Software screens in this manual are example screens 
only. The actual screens for your analyzer can be viewed in the appro-
priate Configurator Software for your analyzer.

Minimum PC Requirements for Configurator Software

The Configurator Software requires the following:

•	 DVD drive (for installation).

•	 Pentium 166 or faster.

•	 16 MB RAM.

•	 3 MB of available hard disk space.

•	 Sound Card (for alarms) recommended, not required.

•	 Windows 7 Professional Edition and later. The System 200 Configura
tor Software is not certified to operate with Windows Home Editions.

•	 800 x 600 resolution or higher recommended.

•	 256-color display, 32767 colors (HiColor, 16-bit) recommended.


NOTE
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Installing the Configurator Software

To install the Configurator Software on your computer:

1.	 Insert the Configurator Software DVD in the DVD drive. The auto-
setup program will run and begin the installation by displaying the 
Setup Wizard screen.

	 Click Next to continue. The Select Installation Folder screen will 
appear. By default, the software will be installed in C:\Program Files 
(x86)\AMETEK\AMETEK 9XX Configurator. To install the software in 
a different folder, click Browse to view the Change current destination 
folder screen and navigate to the alternate folder. Select the folder and 
click OK.

	 Click Next to continue with the setup. The Ready to Install screen will 
appear.

AMETEK recommends 
installing the software and 
program icons in the default 
directory.

AMETEK recommends 
having Admin Rights when 
installing this software 
(preferred but not required). 
Consult with your IT 
Administrator before installing 
the software.

Figure 1-1. 
Setup screens.






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2.	 Click Install to initiate the setup. The software will install and the 
Setup Wizard “Finish” screen will appear. Click Finish and then re-
move the DVD from the DVD drive.

The software will create a shortcut icon on the desktop to start the 
software (called Ametek 9XX Configurator).

	 To start the software, navigate to C:\Program Files (x86)\AMETEK\
AMETEK 9XX Configurator and double-click “M900” (or “M920”, 
etc.). Or, from the computer’s desktop, double-click the Ametek 9XX 
Configurator icon.

	 For details about using System 200 Configurator Software to com-
municate with the analyzer, refer to “Establishing Communication 
Between the Analyzer and Computer” in this chapter.


NOTE

Figure 1-2. 
Setup Wizard Finish 
screen.
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Removing the Configurator Software

To remove the Configurator Software from your computer:

1.	 From the Windows Start menu, select Settings (  ) and then Apps.

2.	 Click Apps & features.

3.	 From the Apps & features list select AMETEK 9xx Configurator and 
click Uninstall to automatically remove it.

If any System 200 Software files remain in the C:\Program Files 
(x86)\AMETEK\AMETEK 9XX Configurator folder, delete all 
remaining folders and files.


NOTE
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Configuration Software Overview

This section reviews the Configurator Software setup that is required to 
begin working with the software. Before beginning, you should have 
already installed and commissioned the analyzer as explained in the ana-
lyzer manual.

The general system configurations and calibration changes can be made 
after establishing communications with the analyzer and working from 
one main dialog box (M9XX Properties, Figure 1-3). This dialog box con-
tains numerous screens (tabs) that allow you to set up the analyzer and 
view live data.

Navigating in the Software and Manual

While working with the software, the following rules apply:

•	 From the Setup tab (Figures 1-4, 3-1) navigate to the various configu-
ration and calibration screens by pressing the corresponding Modify 
(Setup) button. For information about saving changes to these screens, 
see “Working From the Setup Tab” in Chapter 3.

	 If a button is greyed out, the function is not available for the analyzer. 
If all buttons are greyed out, the software is not communicating with 
the analyzer.

Figure 1-3. 
M9XX Properties dialog 
box (General tab).

Configurator Software Version

Check box selected

 Analyzer Information 
 message box
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•	 To view live concentration values or information about the Optical 
Bench or analyzer, choose the Status, Analyzer Data, or Optical Bench 
Data tab from the M9XX Properties dialog box.

•	 To return to the Setup tab from any screen, click OK or Cancel.

•	 Live values on the screens are updated at one-second intervals. When 
switching to a different screen, it may take up to one second for a new 
set of values to be displayed.

•	 While working with the software, use the following navigation buttons:

Press this button to view the Devices & Log window.

Press this button to start a new Custom Configuration mode.

Press this button to navigate to the computer’s hard drive to locate 
files, such as the Configurator file (“9XX.dyc”).

Press this button to save the configuration data.

Press this button to print scanned data (such as Measure/Reference 
PMT signals) from the analyzer.

	 Reminder icon: 
The reminder icons in this manual indicate related information 
about the topic, certain actions that are necessary before 
continuing with the current procedure, or information that is 
recommended by AMETEK. See example at left.

	 Configurator Software navigation icon: 
The navigation icons in this manuals indicate the menu structure 
to follow to view a menu, sub-menu, or analyzer information 
while working from the software.

	 In the example at left (see Figure 1-4), after the Configurator 
Software is first started, the AMETEK Configurator main window 
will appear (Devices & Log window is active in this window). To 
initiate a Manual Zero, double-click Dev1 (<<Device Name>>) 
on the Devices & Log window to view the M9XX Properties 
dialog box. From here, view the Setup tab and click the Gas 
Calibration button to view the Gas Calibration dialog box. Finally, 
if all requirements have been met to initiate the Zero, click the 
ManZero button.

Example: 
AMETEK recommends 
installing the software and 
program icons in the default 
directory.

Example: 
AMETEK Configurator 
windowDev1 (Devices & 
Log window)Setup tab 
Gas Calibration dialog box 
<<ManZero button>>
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Figure 1-4. 
Navigating in the 
software, example.

Double-click Dev 1 (<< Device Name >>) 
to open the M9XX Properties dialog box







Setup tab 
(M9XX Properties dialog box)

Gas Calibration 
button (Setup tab)

Manual Zero calibration button 
(Gas Calibration dialog box)
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Starting the Configurator Software and Establishing 
Communication Between the Analyzer and Computer

You establish communication with the analyzer by using a computer run-
ning AMETEK’s Configurator Software. 

Hazardous Locations 
Before attempting to connect the serial cable between the analyzer and 
the computer, take all necessary safety precautions and test the area 
around the analyzer for explosive gases and proceed only when the 
area is found to be safe. 
 
Do not open the analyzer enclosures and do not power up/down the 
analyzer or computer if there is an explosive gas atmosphere present.

To establish communication with the analyzer:

1.	 Connect the supplied serial communication cable between the com-
puter and the RS-232 serial communication port (located at P100 on 
the Termination board inside the analyzer Electronics Enclosure).

2.	 Power up the computer and start the Configurator Software using one 
of two methods:

•	 Navigate to C:\Program Files (x86)\AMETEK\AMETEK 9XX 
Configurator and double-click “M900” (or “M920”, etc.).

•	 Click the AMETEK 9XX Configurator icon on the computer’s 
desktop.

	 The software will start and the Devices & Log window will appear 
in the AMETEK M9XX Configurator window (Figure 1‑4). If the 
Add Device dialog box is displayed, ensure a device is selected and 
click OK. From the Edit menu, click Device Properties. The M9XX 
Properties dialog box (General tab) will appear (Figures 1-3, 1-4).

The M9XX Properties dialog box is your main interface with the 
analyzer when viewing live data, or when modifying or viewing the 
analyzer’s configuration or calibration parameters.

	 By default, Device Enabled and Live Data are enabled. When Live 
Data is enabled, the software automatically attempts to establish com-
munication with the analyzer. If the communication attempt fails, the 
communication settings may be incorrect and/or the serial cable may 
not be connected properly (or it may be damaged), or you may be 
attempting to communicate with the wrong model of analyzer. Check 
the Status message and see “Configurator Software Troubleshooting” 
in this chapter for information about how to resolve communication 
problems.


NOTE

!
WARNING
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3.	 Confirm or configure communication settings by clicking Setup to 
view the Communication Settings dialog box. Select the appropriate 
communication parameters required to establish communication with 
the analyzer, either Modbus Serial or Modbus TCP (see Chapter 2).

	 After configuring analyzer communication parameters, click OK to 
initiate communication with the analyzer. The software will revert 
to the M9XX Properties dialog box (General tab, Figure 1‑3) and the 
analyzer will be “Online” as indicated in the Status message box.

If at any time you close the M9XX Properties dialog box (by click-
ing OK or Cancel), the software will revert to the AMETEK M9XX 
Configurator window. Return to the Setup Properties dialog box by 
clicking Edit and then Device Properties.

Closing the Configurator Software

Hazardous Locations 
Before proceeding, test the area around the analyzer for explosive 
gases and proceed only when the area is found to be safe.

After you are finished communicating with the analyzer, close the 
Configurator Software and disconnect the computer from the analyzer:

1.	 From the M9XX Properties dialog box, click OK or Cancel.

2.	 From the AMETEK M9XX Configurator window, select File/Exit. 
Click Yes to exit the software.

3.	 Power down the computer and disconnect the serial cable from the 
analyzer’s communication port.


NOTE

!
WARNING

For Modbus Serial or 
TCP setup information, see 
Chapter 2.
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Configurator Software Troubleshooting

This section describes problems (alarms or “errors”) that may be encoun-
tered while attempting to establish communication between the analyzer 
and the computer, or when starting the software. Communication error 
messages can be displayed in the Status field on the General tab (Figure 
1-3) and in the Devices & Log window (Figure 1-8). If this window is not 
displayed in the M9XX Configurator main window, select View\Devices 

& Log or click    to display it.

If communication problems occur, review this section and perform the 
corresponding corrective action to fix any problems.

Problem Encountered 
The “Wrong Device” message is displayed on the Devices & Log window.

Corrective Action 
Check the analyzer markings to ensure the model number is the same as 
indicated in the Configurator Software. The software is intended for specific 
analyzer models and cannot communicate with other models of analyzers. 
 
The Communication Protocol or Settings may be incorrect. Review the set-
tings in the Communication Settings dialog box (Modbus Serial or Modbus 
TCP) and verify or change them to the proper settings. The Slave ID (ad-
dress) in this dialog box must also match the analyzer Address setting in the 
Modbus dialog box (from the Setup tab). See also Chapter 2.

Problem Encountered 
“Connected” is displayed on the Devices & Log window, but the software is 
not communicating with the analyzer.

Corrective Action 
Enable Live Data (General tab) to establish communication.

Problem Encountered 
“DEMO Online” is displayed in the Status field on the General tab. This 
message will be displayed if Live Data is not selected (but Device Enabled is).

Corrective Action 
Enable Live Data to establish communication.
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Problem Encountered 
“OFFLINE” is displayed in the Status field on the General tab.

Corrective Action 
Ensure both Device Enabled and Live Data (General tab) are selected to 
establish communication. 
 
Check the serial cable for proper connections and for damage such as cuts, 
nicks, or burn marks. Also, check it to ensure the internal wiring is terminat-
ed at the connectors.

Problem Encountered 
“DISABLED” is displayed in the Status field on the General tab. This mes-
sage indicates the computer is connected to the analyzer but not communi-
cating with it.

Corrective Action 
Enable Device Enabled, if necessary, to establish communication. 
 
Check the analyzer markings to ensure the model number is the same as the 
Configurator Software. The software is intended for specific analyzer models 
and cannot communicate with other models of analyzers.

Problem Encountered 
Device Properties under the Edit menu is greyed out (access to the M9XX 
Properties dialog box is not available). If this occurs, the analyzer configura-
tion and calibration parameters cannot be viewed or modified. This problem 
suggests that the “M9XX.dyc” file has become corrupt.

Corrective Action 
Delete the “M9XX.dyc” file from the C:\AMETEK\M9XX folder. The software 
will restore this file (and correct the problem) the next time it is started.
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General Tab

When the analyzer is connected to the PC, the current Host Controller 
Firmware Version Number and analyzer Serial Number will be displayed 
in the analyzer information message box to the right of PC Communications 
under the General tab.

Other parameters include:

PC Communications 
Displays information that has been configured from the 
Communication Settings dialog box.

Setup 
Allows you to choose the communication option required to 
establish communication with the analyzer, either Modbus Serial 
or Modbus TCP and enter or select the appropriate information. 
Detailed descriptions about these communication options are 
discussed under “Modbus Serial / Modbus TCP Communication 
Setup” in Chapter 2.

Device

Name 
Enter a tag number or tag name.

Description 
Enter a description to further define the analyzer, such as a loca-
tion or area where it is installed in the plant.

	 This can be useful if using a Multi-Drop system, where multiple 
analyzers are wired together on the same line. In this case, you can 
assign different names and descriptions for each analyzer.

Save Configuration button 
Saves the current analyzer configuration parameters to a file that 
can be used later to restore the settings. See “Saving Analyzer 
Configuration Parameters” in this chapter for details about how to 
save configuration settings to a file.

Restore Configuration button 
Retrieves previously saved analyzer configuration parameters 
from a “.dev” file on the computer. See “Restoring Analyzer 
Configuration Parameters” in this chapter for details about how to 
restore configuration data to an analyzer.
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Device Enabled

Checked (default)	 Allows communication with the ana-
lyzer, and allows the user to set up system 
configurations.

Not Checked	 Device communication is disabled.

Live Data

Checked (default)	 Software uses live data from the analyzer.

Not Checked	 Software uses demonstration data.

Status 
Displays the status of the analyzer (device) you are communicating 
with. Refer to “Configurator Software Troubleshooting” in this chapter 
for information about how to correct the problem.

“OFFLINE”	 Displayed if the PC is not communicating 
with the analyzer (one or both of the Device 
Enabled and Live Data check boxes are not 
selected).

“Online”	 Displayed if the PC is communicating with 
the analyzer (Device Enabled and Live 
Data check boxes are selected).

“DISABLED”	 Displayed if the PC is connected to the 
analyzer but is not communicating with it 
(Device Enabled and Live Data check boxes 
are not selected).

“Device Not Found”	 Displayed if the analyzer’s Serial 
Port Configurations do not match the 
computer’s.

“DEMO Online”	 Displayed if the PC is not connected to the 
analyzer (or the Live Data check box is not 
selected and the Device Enabled check box 
is selected).

Configurator Software version 
Displays the version of Configurator Software running (located to the 
right of Live Data).
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User Interface

The software allows you to customize how data is viewed and to set up 
your display. This is done from the Main Window.

Setting Up Your Screen

Using the View menu items, set up your software by selecting the tool-
bars you want displayed. If the option has a check mark beside it, the 
toolbar is active. To toggle these functions on/off, select the menu option 
again. The areas that make up the Main Window include:

•	 Standard Toolbar
	 Contains icons that are used most often including the main display 

modes.

•	 Custom Mode Toolbar
	 Contains icons that are used to create Custom mode displays.

•	 Data File Toolbar
	 Contains icons that are used to save data files.

•	 Status Bar
	 Located at the bottom of the window, the Status Bar displays system 

messages, including information such as if the system is currently 
scanning.

Figure 1-5. 
Configurator Software 
main window (Trend 
mode display active).

Data File Toolbar

Main Window

Custom Mode Toolbar
Standard Toolbar

Status Bar
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View / Configure Analyzer Parameters and Data

The M9XX Properties dialog box – which is your primary interface with 
the analyzer – contains several tabs (screens of information) that allow 
you to set up communications, view real-time and historical data, and 
modify configuration and calibration parameters for the analyzer. When 
the software is first started, this dialog box defaults to the General tab. 
The descriptions of the parameters on this and other screens can be found 
throughout this manual.

Similar to working from the analyzer User Interface Panel, the 
Configurator Software also operates in RUN, ConFiGuration (CFG), or 
CALibration (CAL) modes.

•	 In RUN mode, analyzer parameters and variables can only be viewed; 
they cannot be deleted or modified. When in RUN mode, the mes-
sage “Password protected” is displayed in the message box next to the 
Modify buttons on the Setup tab.

•	 In CFG mode, you can make changes to operation constants and con-
figuration parameters. A password is required to make configuration 
changes.

Access to the CFG mode should be restricted to trained technicians or 
electricians. Contact your local administrator for passwords. 
 
The settings for your analyzer have been configured at the fac-
tory to meet specified customer requirements. Changing the 
factory-set configuration could cause the analyzer to operate 
incorrectly.

•	 In CAL mode, you can make changes to variables required to tailor 
the analyzer for a specific application and to calibrate the instrument. 
A password is required to make changes to calibration functions.

When in CFG mode, the message “in CFG access mode” is displayed 
in the message box next to the Modify buttons on the Setup tab. 
When in CAL mode, the message “in CAL access mode” is displayed 
here. When in both CAL and CFG mode, the message “in CAL+CFG 
access mode” is displayed here. 
 
Passwords for CFG and CAL modes are in effect until you click the 
Back to Run Mode button from the Info (Analyzer Information) dia-
log box. Clicking this button reverts the software back to RUN mode.


NOTE

!
CAUTION
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Entering CFG and CAL Mode Passwords

To enter CFG and CAL mode passwords:

1.	 Select Analyzer Info from the Setup tab to view the Info dialog box.

2.	 Enter the password for each mode, in the Enter CAL mode password 
here and Enter CFG mode password here text fields.

3.	 Click OK to return to the Setup tab and select the configuration but-
tons to make the required changes.

Figure 1-6. 
Analyzer Information 
dialog box.
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Changing Passwords

Passwords can be a maximum of nine characters. Since this password is 
also updated in the analyzer’s EEPROM, use only the same characters for 
passwords as those used to enter passwords from the User Interface Panel 
(•, –, 1, 2, 3, 4, 5, 6, 7, 8, 9, 0). Do not use letters, since the keypad on the 
User Interface Panel does not use letters.

To change a password:

1.	 Select Analyzer Info from the Setup tab to view the Info dialog box 
(Figure 1-6).

2.	 In the Enter Password text field (Password Update group), enter 
the password that will allow you to change CAL and CFG mode 
passwords.

	 Then, click the Update button to view the CAL and CFG Password 
Update dialog box.

3.	 Enter a new password for CAL and CFG mode. Be sure to record the 
passwords and keep them in a safe place for reference.

4.	 Click OK to accept the changes.

Figure 1-7. 
CAL and CFG 
Password Update 
dialog box.

The factory-default 
password is ‘• •’ for both CAL 
and CFG modes.
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Viewing Device Activities

The Devices & Log window displays the status of all analyzers (devices), 
plus a system event log of all analyzer operations. This window, which is 
displayed within the M9XX Configurator main window (Figure 1-4), can 
help you diagnose problems with the analyzer.

To display the Devices & Log window:

1.	 From the View menu, select Devices & Log or click   . A log is 
displayed showing all active devices and their status.

The system log is saved in a text file in the “Log” folder.

2.	 From here you can view a log of all related activity for active devices 
such as when scans were started or completed as well as any alarm 
conditions. It also provides information on the data source for the 
reading under the Source field (e.g., Dev1, or Device 1). The Status 
field indicates the current status of the analyzer (e.g., Online).

3.	 To remove the display, select View and then Devices & Log again or 

click   .

Figure 1-8. 
Devices & Log 
window.


NOTE
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Saving Analyzer Configuration Parameters

The software allows you to save current analyzer (device) setup configu-
ration parameters to a file that can be used later as a reference or to restore 
the parameters to their original settings (if they are changed). This is use-
ful to create a backup copy of the analyzer configuration parameters, or if 
you will be replacing the analyzer’s EEPROM.

If major changes are made to the analyzer configuration parameters, 
it is important to make a backup copy of these settings. This file can 
then be used to restore all parameters to their original (or latest) set-
tings in the event of an EEPROM failure or it being damaged physi-
cally or electrically.

To save configuration parameters:

1.	 View and record the following information to use as a reference after 
the software upgrade is complete:

a.	 Record the current version of the Host Controller and 
Microcontroller software:

	 From the User Interface Panel: 
Press F5 1 from RUN mode to view the Host Controller software 
version. Record the version number and ensure it is an older ver-
sion than that being replaced.

	 Press F5 2 from RUN mode to view and record the Microcontroller 
software version. Record the version number and ensure it is an 
older version than that being replaced.

	 From the Configurator Software: 
From the General tab, view and record the current version of the 
Host Controller (HC ver) and Microcontroller (MC ver) software, 
located to the right of PC Communications on this tab. Ensure it is 
an older version than that being replaced.


NOTE
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b.	 Record the current analyzer and Configurator Software Modbus 
address settings (if applicable). These settings must be restored 
later to allow communication between the analyzer and the 
Configurator Software or remote work station.

	 From the User Interface Panel: 
Model 9xx-Series Analyzers that did not use the Configurator Software 
before the embedded software upgrade:

•	 Model 909, 910, 919, 920 Analyzers: 
From the User Interface Panel, press F2 • from RUN mode to 
view the current analyzer Modbus setting.

•	 Model 900, 930 Analyzers: 
From the User Interface Panel, press F4 • from RUN mode to 
view the current analyzer Modbus setting.

•	 All Model 9xx-Series Analyzers that were using the Configurator 
Software before the embedded software upgrade: 
Working from the Configurator Software, click Modbus from 
the Setup tab. Record the value of the Modbus Address field 
(this is the current analyzer Modbus setting).

	 From the Configurator Software: 
From the Configurator Software, click Modbus from the Setup tab. 
Record the value of the Modbus Address field (this is the current 
analyzer Modbus setting).

	 From the General tab, click Setup to view the Communication 
Settings dialog box. Verify/record the communication option 
(Modbus Serial or Modbus TCP) and settings. These are the 
Configurator Software settings that must match those of the 
analyzer.

2.	 From the General tab, click Save Configuration to view the Save 
As dialog box. To store the file, navigate to C:\Program Files (x86)\
AMETEK\AMETEK 9XX Configurator on the computer’s hard drive.

3.	 Name the file and click Save. The file will be saved with a “.dev” ex-
tension. This file can be used only by the Configurator Software. 

The procedure is complete.

General (tab) 
<<Save Configuration>>
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Restoring Analyzer Configuration Parameters

The Configurator Software allows you to retrieve previously saved ana-
lyzer configuration parameters to restore the parameters to their original 
settings. This function is useful if you wish to recover analyzer configura-
tion parameters if changes have been made that you do not wish to keep, 
or to restore the settings after replacing the analyzer’s EEPROM in the 
event of an EEPROM failure. The configuration parameters are stored in a 
“.dev” file on the computer.

To restore configuration parameters:

1.	 From the General tab click Restore Configuration to view the Open 
dialog box.

2.	 Navigate to the location of the file (e.g., C:\Program Files (x86)\
AMETEK\AMETEK 9XX Configurator), select it, and click OK to re-
store configuration parameters to the analyzer you are communicating 
with.

	 During the parameters restoration, the analyzer will temporar-
ily go “OFFLINE”. After the restoration is complete, the Name and 
Description will change to reflect those of the saved parameters.

3.	 View the Devices & Log window. If the file restoration is successful, 
the message “This new CFG has been restored successfully!” will be 
displayed.

	 If the file that is being restored contains identical information as that 
already saved to the analyzer’s EEPROM, the message “The restored 
CFG is not new!” will be displayed in the Devices & Log window. 

The procedure is complete.

General (tab) 
<<Restore Configuration>>
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CONFIGURING COMMUNICATION PARAMETERS

This section provides instructions on how to set up the System 200 
Configurator Software to establish communication between your ana-
lyzer and your computer, via either Modbus Serial or Modbus TCP 
communication.

Modbus Serial / Modbus TCP Communication Setup

To set up the analyzer to allow Modbus Serial or Modbus TCP communi-
cation between it and the computer:

1.	 Start the Configurator Software. The M9XX Properties dialog box 
(General tab) will appear.

2.	 Click the Setup button (or click the Live Data check box) to view the 
Communication Settings dialog box (Figure 2-1, defaults to Modbus 
Serial). If you require Modbus TCP, select it. The screen will change 
to display TCP parameters (Figure 2-2).

Figure 2-1. 
Communication 
Settings dialog box 
(Modbus Serial 
communication).

Figure 2-2. 
Communication 
Settings dialog 
box (Modbus TCP 
communication).
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3.	 Enter or select the communications information for either selection:

	 Settings

Port (Modbus Serial only) 
Select the COM port on the computer used to communicate 
with the analyzer.

Stop Bits (Modbus Serial only) 
Displays and allows you to select the number of stop bits of the 
Modbus network.

Parity (Modbus Serial only) 
Displays and allows you to select the parity of the Modbus 
network.

Baud (Modbus Serial only) 
Baud rate at which data will be transferred. The baud rate is 
fixed at 9600.

IP Address (Modbus TCP only) 
Enter a unique address for each analyzer. This is determined 
based on network settings for the analyzer.

Slave ID 
This is the Modicon Modbus® slave address of the analyzer. If 
the RS-232 port is selected, the address setting is not applicable 
(it is greyed out). 
 
If the RS-485 port is selected, be sure to enter a unique Modbus 
address (Slave ID) for the analyzer. 
 
For Modbus Serial communication interface: 
0 = Disabled 
1–255 = Enabled 
 
For Modbus TCP communication interface: 
0,1 = Disabled 
2–255 = Enabled

Time out (ms) 
Enter a time out value (duration) that the software will use 
to attempt to establish communications with the analyzer. 
AMETEK recommends a value of 1000 ms.

If you are unsure of the Modbus address assigned to the analyzer, you 
can use the “back door” access code (i.e., enter 255 in the Slave ID 
field) to allow communication between the analyzer and the computer.


NOTE
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4.	 Click OK to initialize communication with the analyzer. The software 
will revert back to the M9XX Properties dialog box and the analyzer 
will be Online, as indicated in the Status message box.

If the computer cannot establish communication with the analyzer, 
refer to “Configurator Software Troubleshooting” in Chapter 1 for 
information about how to correct the problem.

5.	 View the Status tab. Live data should begin updating within 10 
seconds.


NOTE
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CONFIGURATION and CALIBRATION

To change ConFiGuration (CFG) and CALibration (CAL) parameters, you 
must first enter a password to enter CFG and/or CAL mode, similar to 
working from the analyzer User Interface Panel. Information about how 
to enter passwords from the Configurator Software is described under 
“Entering CFG and CAL Mode Passwords” in Chapter 1.

Working From the Setup Tab

The Setup tab contains all functional parameters that control the opera-
tion of the analyzer. These screens, which allow you to view all informa-
tion about the analyzer, are accessed by clicking the appropriate Modify 
button.

The settings for your analyzer have been configured at the factory to 
meet specified customer requirements. Changing the factory-set con-
figuration could cause the analyzer to operate incorrectly.

!
CAUTION

Figure 3-1. 
Setup tab, example 
screen.

Message box

Save CFG to EEPROM button
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Access to the CFG mode should be restricted to trained technicians or 
electricians. 
 
The settings for your analyzer have been configured at the fac-
tory to meet specified customer requirements. Changing the 
factory-set configuration could cause the analyzer to operate 
incorrectly.

IMPORTANT 
The Setup screens on this tab cannot be accessed unless communica-
tion between the software and the analyzer has been established. If 
functions on this tab are greyed out, check the status of the system 
from the General tab. You will have to establish communications with 
the analyzer before you can view or configure its parameters. 
 
Depending on the analyzer, some functions may not be available 
(greyed out). To view the screens for your analyzer, view the software.

Occasionally, the System 200 Configurator Software will truncate 
values or round values up or down. The rounding problems in turn 
can cause some data values to drop each time that data is written to 
the analyzer and then read back into the Configurator Software. 
 
To ensure these problems do not occur, enter and save all values from 
the User Interface Panel. The rounding problem can also occur 
when entering information from the User Interface Panel.

While changing parameters from any of the Setup Configuration/
Calibration dialog boxes, observe the following functions and rules:

•	 Information and/or functions that are greyed out are not applicable or 
currently unavailable for the analyzer you are currently working with.

•	 After changing any of the parameters or their values from any setup 
screen, you must click the OK or Apply button on that screen (or 
within the group) to activate the new settings. These new settings will 
be sent to the analyzer.

	 If any configuration parameters have been changed, the Save CFG to 
EEPROM button (Setup tab) will become active (Figure 3-2) to allow 
you to save the change (permanently) to the analyzer’s EEPROM. If 
you only want the changes to be in effect temporarily, do not click the 
Save CFG to EEPROM button.

!
CAUTION


NOTE


NOTE
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Parameters in groups that have their own Apply button cannot be 
reverted to their original state by clicking the Refresh button if the 
changes have already been applied.

•	 You can change numerous parameter values on a screen before click-
ing OK or Apply.

•	 The Refresh button on the Setup tab updates any changes made 
to the analyzer from its User Interface Panel to the Configurator 
Software. See “Refreshing Configuration Parameters” in this chapter 
for more information.

•	 On individual setup screens, click Refresh to change the values back 
to their original settings. When you click this button, any values that 
you have changed but do not wish to set permanently will revert to 
the settings that were last saved to the system’s EEPROM. Changes 
can only be refreshed (reverted to their original setting) if they haven’t 
already been applied (before you click the OK or Apply buttons) 
or saved (before you click the Save CFG to EEPROM button on the 
Setup tab).

•	 If you want the parameter changes to be valid only for the current 
session, do not click Save CFG to EEPROM. The changes will revert to 
the previously saved changes after the system is powered down and 
then powered up again, or if the analyzer is reset.

•	 You can make changes to all or some of the Modify Configuration 
dialog boxes before clicking Save CFG to EEPROM.


NOTE

Figure 3-2. 
Setup tab, example 
screen with Save CFG 
to EEPROM button 
active.
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Modify 
Contains numerous buttons that allow you to view and set up differ-
ent aspects of the analyzer. These buttons and their setup screens are 
discussed in detail in the following pages.

Depending on the analyzer you are working with, some functions 
(dialog boxes) accessed from the Modify buttons may not be available. 
Functions that are not available for a given analyzer are greyed out. 
 
Dialog boxes for each of the Setup Configuration/Calibration screens 
discussed in this chapter are sample screens only. Refer to the actual 
screens in the software for enabled/valid parameters for your analyzer. 
Also, refer only to the descriptions of the enabled functions on these 
screens, as listed throughout this chapter.

IMPORTANT 
The Setup screens on this tab cannot be accessed unless communica-
tion between the software and the analyzer has been established. If the 
functions on this tab are greyed out, check the status of the system 
from the General tab. You will have to establish communications with 
the analyzer before you can view or configure its parameters. 
 
Depending on the analyzer, some functions may not be available 
(greyed out). To view the screens for your analyzer, view the software.

Message box 
The message box (to the right of the Modify buttons) displays infor-
mation about the software and analyzer it is currently communicating 
with.

	 For example, “in CFG + CAL access mode” indicates the passwords 
for both the Calibration and Configuration modes have been entered, 
allowing the user to make changes to the CFG and CAL parameters.

	 The Model ID (identification) number is also displayed to indicate the 
model of analyzer currently communicating with the analyzer. The 
ID number corresponds with a list that can be seen in the Analyzer 
Information dialog box.

Save CFG to EEPROM	  
Click this button to permanently save any changes you have made to 
operating parameters to the analyzer’s on-board EEPROM.


NOTE


NOTE
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Saving Analyzer Configuration Parameters to an 
ASCII File

When you select the Print to File button from the Setup tab, the Save As 
dialog box appears. Navigate to the path you wish to save the file to, name 
the file, and click Save. The software saves the current analyzer configura-
tion parameters to an ASCII file (called “EEPROM Data”). Note that the file 
will be saved with a “.dmp” extension. This function can be used to back up 
analyzer Calibration and Configuration parameter settings.

Include a date in the file name (e.g., M900_Cfg_08-15-2017). The file 
name is included in the header when you open the file.


NOTE

Printing Analyzer Configuration Parameters

To print the current analyzer configuration parameters, select the Print 
(Setup tab). From the Print dialog box, click OK.

Figure 3-3. 
Save As dialog box 
(Print to File button).

Figure 3-4. 
Print dialog box 
(Print button).

AMETEK recommends 
saving and storing these files 
in C:\Program Files (x86)\
AMETEK\AMETEK 9XX 
Configurator.

A printer must be 
connected directly to the PC 
or via a network.
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Refreshing Configuration Parameters

When you make changes while working in CFG or CAL mode from the 
analyzer User Interface Panel, the Refresh button on the Setup tab (Figure 
3‑2) will flash to indicate that configuration or calibration changes have 
been made. When you click Refresh, the software polls the CFG and CAL 
parameters at the analyzer and updates the changes in the Configurator 
Software with the original analyzer settings.

When changes are made from the analyzer User Interface Panel, the mes-
sage “Button ‘Refresh’ is flashing. Possible panel operation” is displayed 
in the message box next to the Modify buttons on the Setup tab.

Saving Configuration Parameters to EEPROM

After changing parameters or their values from any setup screen, click 
OK to return to the Setup tab (Figure 3‑2). Parameter changes are evident 
when the Save CFG to EEPROM button is active. Click this button to 
activate the new settings and to permanently save the new value(s) to the 
analyzer’s EEPROM.
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Optical Bench

The Optical Bench dialog box allows you to modify Optical Bench con-
trol and to view and modify data acquisition parameters. A password is 
required to change these parameters.


NOTE

‘**’ following the parameter names below indicates the parameter 
should only be modified by a trained technician.

Lamp Base (mV)** 
This defines the base-current set point for each source lamp (1 and 2), 
which is the minimum operating current. Do not change this. 
 
1  =  Lamp 1 (closest to the Measuring Cell) 
2  =  Lamp 2 (farthest from the Measuring Cell)

Default Filter Pulses (mV) 
Defines the source lamp pulse current-control signal for each filter. 
The normal operating range is between the Lamp Base and the Lamp 
Max settings (check EEPROM Data Sheets for actual value); the con-
trol signal for the key filter is Lamp Max. If a filter position is not used, 
the Default Filter Pulses value must be set to a negative number. The 
recommended value is negative base (-2000 mV) set point.

Figure 3-5. 
Optical Bench 
dialog box (multi-gas 
analyzers).

Setup (tab)Optical 
Bench
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ALC SetPt (mV)** 
The Automatic Lamp Control Setpoint signal is obtained from the 
Reference PMT for each filter (up to six) after the Auto-Setup is com-
plete. These values are updated automatically by an Auto-Setup. The 
Automatic Lamp Control function adjusts the lamp pulses to maintain 
the Reference PMT signals to these values.

ALC Gains** 
This is the automatic lamp-control gain setting for each filter.

Tzero** 
This is the PMT signal transmittance value of each filter, with Zero 
gas in the sample system. It is adjusted automatically whenever the 
analyzer is Zeroed.

ALC On button 
The Automatic Lamp Control automatically turns on at the comple-
tion of an Auto-Setup, and should be on during normal operation. 
However, this function should be turned off while performing a lamp 
alignment.

Checked (default)	 Automatic Lamp Control function is 
enabled.

Not Checked	 Automatic Lamp Control function is 
disabled.

Bench Type** 
Defines the Optical Bench orientation and the filter sequence assigned 
to each source lamp. Do not change this.

	 Orientation	 The physical orientation of the Optical 
Bench:

		  0 = Normal (typical, factory default) 
The Measuring Cell is connected to the 
Optical Bench on the left side of the ana-
lyzer, when facing it.

		  1 = Reverse 
The Measuring Cell is connected to the 
Optical Bench on the right side of the ana-
lyzer, when facing it.
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	 Filter Sequence	 This factory-set default specifies the order 
in which the filters pass in front of the light 
path of the source lamps. Options include:

		  0 = 1-3-5, 4-6-2 (typical, factory default)

		  8 = 3-5, 4-6-1-2 (custom applications)

		  16 = 1-3-4-5, 6-2 (custom applications)

		  24 = Invalid is used for analyzers without 
a Chopper Motor, which houses up to six 
filters. Typically reserved for Model 909, 919 
Analyzers.

Processing Filtration

	 MaxT90 (sec)	 This is the time (default is 60 seconds) 
required for the output signal to reach 90 
percent of the final value after a step change 
in the concentration. Larger values reduce 
the noise level on the output signal but, at 
the same time, increase the sample response 
time. Do not change this.

	 Adaptive Parameter 1	 This is the adaptive filtering algorithm 
constant (default is 0.00025) for Filter 1 on 
single-species analyzers, such as Models 909, 
919. Do not change this.

	 Adaptive Parameter 2	 This is the adaptive filtering algorithm 
constant (default is 0.00025) for Filter 2 on 
single-species analyzers, such as Models 909, 
919. Do not change this.

Completion Number 
Displays the completion number for the latest Auto-Setup (located 
below Processing Filtration). See the description of the Auto-Setup 
button for more information.

Samples per Peak** 
Indicates the number of times the PMT signal is measured while a 
filter is completely within the light path.

Delay (x1.6 µs)** 
This is the time interval between when the filter becomes completely 
within the light path and the first PMT signal measurement. The inter-
val is shown as multiples of 1.6 microseconds (µs).
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Wheel Revolutions for Avg RPM** 
This is the number of filter wheel rotations per minute (RPM) used to 
calculate its RPM during one measuring cycle. Model 900, 910, 920, 
930 Analyzers only.

K Msr** 
This is the molar absorptivity of the gas species at the wavelengths 
used, for the Measure PMT signal. Model 909, 919 Analyzers only.

K Ref** 
This is the molar absorptivity of the gas species at the wavelengths 
used, for the Reference PMT signal. Model 909, 919 Analyzers only.

Key Filter** 
This displays the position of the key filter, which gives the weakest sig-
nal for a given source lamp current.

PMT Level (mV)** 
This displays the Photomultiplier Tube gain control signal, which is 
based on the signal from the PMT when the key filter is in the light 
path. Normal values after a successful Auto-Setup are from 7.2–7.4 
VDC. If the PMT Level is not in this range, adjust the Lamp Max and 
start another Auto-Setup.

PMT Balance (mV)** 
This displays a secondary Photomultiplier Tube control signal, which 
adjusts the PMT gain to equalize the PMT signals when the filters with 
the lowest and highest transmittances are in the light path. Normal 
values after a successful Auto-Setup are from 4.0–7.0 VDC.

Lamp Max (mV)** 
This displays the voltage to which the lamp pulse current-control sig-
nal for the key filter location is set during the Auto-Setup. To ensure a 
PMT Level of 7.2–7.4 VDC after an Auto-Setup, the Lamp Max typical 
range is 4.5–7.8 VDC. (Check EEPROM Data Sheets for actual value.)

Signal Max (mV)** 
This displays a value that is used by the Auto-Setup to adjust the PMT 
signal (Reference or Measure PMT) with the highest gain. The PMT 
signal with the highest gain is set to SigMax when each filter is in the 
light path while the Auto-Setup is in progress. SigMax should be be-
tween 8.0 and 9.0 V. (Check EEPROM Data Sheets for actual value.)
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Display 
These message lines display the same information as that currently 
being displayed on the analyzer User Interface Panel.

	 During normal operation, these message lines display the real-time 
status of the species being measured (top line) and its concentration 
value (bottom line).

	 When an Auto-Setup is in progress, messages indicating the current 
stage of the Auto-Setup are displayed on the top line. Auto-Setup mes-
sages include:

•	 Adjusting PMT Level
•	 Adjusting Lamp Pulses
•	 Adjusting PMT Balance
•	 Adjusting PMT Level
•	 Adjusting Lamp Pulses
•	 Setting Up ALC
•	 Off/Completed

	 This information is also displayed on other screens.

	 Green text = normal conditions. 
Red text = Warning or Fault alarm active. 
 
If an alarm is active, refer to the analyzer manual (“Maintenance and 
Troubleshooting” chapter) for details about the alarm and corrective 
action to take to reset the alarm.

Auto-Setup button 
Initiates the Automatic-Setup function, which optimizes the PMT 
gains and source lamp currents. This function combines automatic 
signal adjustment with manual jumper positioning (refer to the 
“Maintenance and Troubleshooting” chapter in the analyzer manual 
for more information). The Auto-Setup process takes approximately 
three minutes. Always perform an Auto-Setup after any lamps, optical 
filters, or PMTs have been installed or replaced.

	 The final Completion Number must be between 0.75 and 1.25. If it is, 
click OK and then click the Save CFG to EEPROM button to save the 
changes. If the completion number is not between 0.75 and 1.25, refer 
to the analyzer manual for more information.

	 After a successful Auto-Setup, return the analyzer to RUN mode by 
clicking the Back to Run Mode button on the Info dialog box.

Cancel Auto-Setup button 
Stops the Automatic-Setup function.
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
NOTE

Cell/Miscellaneous (Compensation) Parameters

The Cell/Misc dialog box contains compensation parameters used in 
calculating the concentration, plus other miscellaneous parameters. They 
account for temperature, pressure, compressibility and other variations 
that affect the concentration reading computed by the analyzer.

‘**’ following the parameter names below indicates the parameter 
should only be modified by a trained technician.

Cell Length** 
Displays the axial length of the Measuring Cell gas space (centimetres 
or inches).

Default Cell Temp 
Displays the default temperature for the Measuring Cell (°C or °F). 
This value is used in place of the Measuring Cell temperature when 
measured temperature compensation is disabled.

Default Cell Pres 
Displays the default absolute pressure for the Measuring Cell (mmHg 
or "Hg). This value is used in place of the Measuring Cell pressure 
when active pressure compensation is disabled.

Figure 3-6. 
Cell/Miscellaneous 
(compensation 
parameters) dialog box.

Setup (tab)Cell/Misc
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Moisture 
Displays and allows you to change (from CFG mode) the ambient air 
moisture content or stack gas moisture content (%) compensation. All 
analyzers except Model 900.

Air Demand Factor 
Displays the Air Demand (F) factor as shown in the Air Demand 
Analyzer calibration data sheet. Do not change this application-specif-
ic factor without first consulting with AMETEK personnel and receiv-
ing approval. Model 900 Analyzers only. Air Demand Factor compo-
nents include:

	 SV – Sulfur vapor at analyzer conditions.
	 COS – COS in the tail gas stream (factory default = zero).
	 CS2 – CS2 in the tail gas stream (factory default = zero).

Compensation Enable** 
Displays the factory-set compensation functions that are used in the 
calculation of the concentration. Depending on your analyzer, some, 
all, or none of these will be enabled (checked). Compensation func-
tions will vary for different analyzers or applications. Model 900, 910, 
920 Analyzers only.

 	 Each of these functions can be set to 0 – Disable, 1 – Passive (Static),  
2 – Disable, 3 – Active (Dynamic), 4 – N/A (not applicable).

	 NDr Comp (Neutral Drift compensation)
	 SV Comp (Sulfur vapor compensation)
	 COS Comp (COS compensation)
	 CS2 Comp (CS2 compensation)

Static 
Displays the factory-set concentration value for the static component 
(N2O – absorbance offset vector) that is used for compensation pur-
poses only. Model 910, 920 Analyzers only.

Result Unit Conversion factors** 
Reserved for other analyzers.

Absorbance Offset** 
Displays the Absorbance Offset vector for each filter location.
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Temperature Control

The Temperature Control dialog box contains temperature control param-
eters for all of the temperature zones measured by the analyzer.


NOTE

‘‘**’ following the parameter names below indicates the parameter 
should only be modified by a trained technician.

Temperature Control Zones**

	 Selection	 This list box defines the factory-set number 
of temperature zones used by the analyzer. 
Options include:

		  0 = no temperature control: 
No temperature zones are being used.

		  2 = 2 temp control zones (1 & 4): 
Temperature zones 1 and 4 are being used. 

		  4 = 3 temp control zones (1, 2 & 4): 
Temperature zones 1, 2, and 4 are being 
used.

		  6 = 4 temp control zones (1, 2, 3 & 4):  
Temperature zones 1, 2, 3, and 4 are being 
used.

Figure 3-7. 
Temperature Control 
dialog box.

Setup (tab)Temp 
Control
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	 Zone 3	 This list box defines the factory-set cooling/
heating logic for temperature zone3. Op-
tions include:

		  0 = cooling logic, SKO: 
Used if Zone 3 is being used for the Sulfur 
Knock-Out.

		  32 = heating logic, heater: 
Used if Zone 3 is reserved for an extra tem-
perature zone.

Zones 
Displays the factory-set temperature zones currently being used 
for the analyzer. Depending on which option is selected from the 
Selection list box, the Zone definitions will be enabled (a name for the 
zone is displayed), or disabled. If the analyzer does not use an ASR900 
Sample Probe, Zone 5 will be greyed out (not used). The descriptions 
of each zone are:

•	 Zone 1 – reserved for Sample Line.

•	 Zone 2 – reserved for Vent Line.

•	 Zone 3 – reserved for SKO (Sulfur Knock-Out) or optionally, SCU 
(Sample Conditioning Unit).

•	 Zone 4 – reserved for Measuring Cell.

•	 Zone 5 – reserved for ASR900 Sample Probe. 
This zone is an extra temperature zone and is typically reserved 
for analyzer Models 900, 930 using the ASR900 Sample Probe.

•	 Zone 6 – reserved for Heater Plate.

Current 
Displays the real time operating temperature for the corresponding 
temperature zone (°C or °F).

Setpoint 
Displays the control operating set point for each temperature zone 
(°C or °F). This value is the temperature control set point at which an 
alarm Warning or Fault will be set and displayed in the software, and 
is used to alert the operator to analyzer operating conditions.
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Kp (band)** 
Displays the proportional term of the PID temperature control algo-
rithm for each temperature zone.

Ti (sec)** 
Displays the integral term of the PID temperature control algorithm 
for each temperature zone (seconds).

Sensor Type** 
Displays the type of sensor used to measure the temperature for each 
temperature zone. 2 = RTD B is the typical default.

Duty Cycle (%)

	 Startup	 This is the default duty cycle percentages 
used upon start-up for each temperature 
zone during steady-state operation at the set 
point.

	 Maximum	 This is the maximum duty cycle percentage 
for each temperature zone.

	 Current 	 This is the real time duty cycle percentage 
for each temperature zone.

Too Cold 
Displays the Measuring Cell temperature (°C or °F) at which the ana-
lyzer’s Flow Control (automatic Sample) mode will switch between 
Continuous Sample mode and Continuous Backpurge mode, provid-
ing each of the other temperature zones is within 5 % of its set point 
value. Entering ‘0’ results in the analyzer using 5 % of the Measuring 
Cell temperature set point as the switch temperature.

Probe Temp Input 
Displays the temperature characteristics of the ASR900 Sample Probe. 
This parameter is used only for certain analyzers that use an ASR900 
Sample Probe to extract the sample gas. These values can also be dis-
played in °F if the units are set to Imperial measurements.

	 at 0.0	 Probe temperature signal low scale for 0 V 
(°C or °F).

	 at full scale	 Probe temperature signal high scale for full-
scale V (°C or °F).
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	 Low Limit	 Probe temperature low alarm set point 
(°C or °F).

	 High Limit	 Probe temperature high alarm set point 
(°C or °F).

HC Scode 
Displays the alarm status code triggered by the Host Controller board. 
This is the sum total of all alarms that have been set.

	 The message box below HC Scode displays the corresponding Scodes 
and their descriptions.
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Output

The Output Setup dialog box contains Current and Voltage output as-
signments. Refer also to the Customer I/O board drawing in the analyzer 
manual.

Analyzers with Dual Range functionality (e.g., so2 = Low Range; 
SO2 = High Range) must be configured from the User Interface 
Panel, as certain parameters are not available in the System 200 
Configuration Software.

There are four independent isolated 4–20 mA DC outputs that can be 
either self-powered or loop-powered. The user must provide the loop 
supply for the loop-powered output.

In addition to the usual capability of Zeroing and Spanning the V/I and 
Voltage Outputs, you can also set them to a mid-scale level for diagnostic 
purposes. The low end of each analog output range can be a non-zero 
value.


NOTE

Figure 3-8. 
Analog Output Setup 
dialog box.

Setup (tab)Output 
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Channel# (1, 2, 3, 4) lists various parameters for each of the four analog 
output channels.

Assignment 
Defines (Output Signal Assignment, or OSA) code for each of the four 
analog outputs. These are typically assigned at the factory, according 
to customer specifications.

Species is the gas type of interest. 
You can assign a different species for each of the four channels. 
Depending on the analyzer, certain options may not be available. 
Options can include SO2, H2S, COS, CS2, Sv, NDr, Air Demand, 
Trend, NOx, Stream flow rate, and O2. N/A is selected if no out-
put is assigned to the channel.

Property is the manner in which the output is provided. 
You can assign a different property for each of the four channels. 
Depending on the analyzer, certain options may not be available. 
Options can include Live Result, Mass emission, O2 Correction, 
T&H result, T&H mass emission, and T&H O2 Correction. N/A is 
selected if no output is assigned to the channel.

	 Show on Display check box

	 Checked (default)	 Displays the analog output information on 
the Display message lines that are avail-
able on the Optical Bench, Gas Calibration, 
and Analyzer Information dialog boxes, the 
Status and Analyzer Data tabs, and on the 
User Interface Panel.

	 Not Checked	 Analog output information will not be 
displayed in the software or on the User 
Interface Panel.

Current Outputs

Low Scale 
Enter the current low scale set point corresponding to 4 mA DC, 
for each of the analog outputs. If an output is not used, set this to 
zero (‘0’).

Full Scale (High Scale) 
Enter the current full (high) scale set point corresponding to 
20 mA DC, for each analog output. If an output is not used, set this 
to zero (‘0’). For example, if Scale 1 = 1000 PPM, Output 1 would 
read 20 mA at 1000 PPM and 4 mA at 0 PPM. These outputs are 
application-specific.
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Zero (mA) 
Enter the measured current (mA) in the current output loop when 
the output is set to zero scale during the Zero calibration proce-
dure, for each analog output. The actual mA value is displayed for 
each corresponding output channel when 4 mA (Zero function) is 
activated.

Span (mA) 
Enter the measured full-scale current (mA) in the current output 
loop when the output is set to full-scale during the Span calibra-
tion procedure, for each analog output. The actual mA value is 
displayed next to the corresponding output channel when 20 mA 
(Span function) is activated.

Result 
Displays the real time output value for each output.

Voltage Outputs 
(Reserved for other analyzers.)
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Modbus Settings

The Modbus dialog box displays current communication parameters for 
the analyzer you are communicating with. The parameters displayed here 
are the results of settings in the analyzer (made from the User Interface 
Panel).

Address 
Displays the Modbus slave address assigned in the analyzer.

Baud Rate 
Displays the baud rate.

Stop Bits 
Displays the number of stop bits.

Parity 
Displays the parity.

The field at the bottom of this dialog box (i.e., RTU 9600 N 8 1) represents 
the current settings.

Figure 3-9. 
Modbus dialog box.

Setup (tab)Modbus

See also Chapter 2.
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Matrix

The Matrix dialog box displays information that is responsible for partially 
calculating the concentration output and negating the effects of cross-talk 
by interfering gas species.

The Matrix dialog box is not used for analyzer Models 909, 919 
(single-species analyzers). For these analyzers, the Matrix button is 
greyed out. 


NOTE


NOTE

‘**’ following the parameter names below indicates the parameter 
should only be modified by a trained technician.

Species** 
This designates which gas species are currently configured for each 
row (up to six).

Row/Filter** 
This displays the value for each species of gas (Row 1–6) and each 
column (Filter 1–6) in the calculation matrix.

Figure 3-10. 
Matrix dialog box.

Setup (tab)Matrix
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‘**’ following the parameter names below indicates the parameter 
should only be modified by a trained technician.

Units of Measurement (factory-set)

	 Bit 0	 Select the units of measurement used for 
displaying concentration, temperature, and 
pressure values. Options include:

		  0 = Metric units: 
Displays the data in metric units.

		  1 = Imperial units: 
Displays the data in imperial units.

	 Bit 1,2	 Select the concentration values in which 
you system data will be displayed (either 
PPM or percent). Options include:

		  0 = Normal concentration (ppm): 
Displays the data in parts per million.

		  2 = Normal concentration (%): 
Displays the data in a percentage.

Analytical Parameters

Analyzers with Dual Range functionality (e.g., so2 = Low Range; 
SO2 = High Range) must be configured from the User Interface 
Panel, as certain parameters are not available in the System 200 
Configuration Software.


NOTE

Figure 3-11. 
Analytical Parameters 
dialog box.


NOTE

Setup (tab)Analytical 
Parameters
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		  4 = Finer (low) concentration result (ppm): 
This is used for low gas concentrations, 
providing a parts per million reading to one 
decimal place (one-tenths).

		  6 = Coarse (high) concentration result (%): 
This is used for high gas concentrations, 
providing a percentage reading.

	 Bit 3	 Select the number of outputs to display. Op-
tions include:

		  0 = Display 4 items: 
Displays four outputs.

		  8 = Display 3 items: 
Displays three outputs.

	 Bit 4	 Select the type of remote function to enable. 
Options include:

		  0 = Remote ACAL: 
Enables the Remote Auto-Calibration func-
tion via a remote contact (from a control 
station).

		  16 = Remote backpurge/Zero flow 
(900/930 Analyzers) 
16 = Remote backpurge  
(909/910/919/920 Analyzers): 
Enables the Remote Backpurge function via 
a remote contact (from a control station).

Kf 
Displays the factory-set units conversion constant for calculation of a 
component’s mass flow (Mass/Energy). 

Ke 
Displays the factory-set units conversion constant for calculation of 
a component’s mass flow (Mass/Amount). Model 909, 910 Analyzers 
only.

NDR Timers

	 1 - TAvg (sec)	 Displays the factory-set amount of time (in 
seconds) for the averaging times of the Neu-
tral Drift compensation functions.

	 2 - Update (sec)	 Displays the factory-set amount of time (in 
seconds) for the update times of the Neutral 
Drift compensation functions.
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Miscellaneous Coefficients

	 T/H	 The Track-and-Hold functions display the 
factory-set value (%) of the specific gas spe-
cies to which the Track-and-Hold function 
will hold. ‘0’ = hold to the analyzer’s cal-
culated output value. The Track-and-Hold 
parameters will vary from analyzer to ana-
lyzer, but the specific functions can be set for 
the required species output.

	 Op Ratio	 Displays a factory-set value for the tail gas 
H2S-to-SO2 ratio at which the plant is to be 
operated. For the conventional operation of 
the modified-Claus Sulfur Recovery process, 
this value is ‘2’.  
Model 900 Analyzers only. 
Do not change this factory-set value with-
out first consulting with AMETEK person-
nel and receiving approval.

	 Op Offset	 Displays the analog output mid-scale 
(12 mA DC) Air Demand Signal. For the con-
ventional operation of the modified-Claus 
Sulfur Recovery process, this value is ‘0’. 
Model 900 Analyzers only. 
Do not change this factory-set value with-
out first consulting with AMETEK person-
nel and receiving approval.

Trend Type 
When these check boxes are checked, the software will display the 
sum concentration of the result for the corresponding gas species. 
Model 900 Analyzers only.

	 The results options, which are listed with the bit number (e.g., b0) 
that is used by the software, include b0 (SO2), b1 (H2S), b2 (COS), b3 
(CS2), b4 (SV), and b5 (NDr). The checked species are factory-set, ac-
cording to customer specifications.

	 Sum Results	 This is a code generated by all of the en-
abled species.
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Linear Coefficients 
This is the calibration parameters used for factory calibration. The 
displayed results will vary, depending on which analyzer you are 
working with (i.e., SO2/NO, or Interferents Linear Coefficients). This 
function is not available for Model 909, 919 Analyzers.

For Model 900 and 930 Analyzers, the results include:

XTalk CVector1 c0–c8 or c0–c9 (1..8/1..9)** 
This displays the factory-set vectors for the first compensation calcula-
tions. (XTalk CVector1 c9 (1..9) is for Model 900/930 Analyzers with 
COS/CS2 software version only.)

XTalk CVector2 c0–c1 or c0–c3 (1..2/1..4)**  
This displays the factory-set vectors for the second compensation cal-
culations. (XTalk CVector2 c2, c3 (1..4) is for Model 900/930 Analyzers 
with COS/CS2 software version only.)

For Model 910, 920 Analyzers, the results include:

Linearization c0–c6** 
This displays the factory-set linearization coefficients that are used to 
provide polynomial correction in the data analysis.

SV TAvg (sec)** 
This displays the factory-set compensation value (in seconds) for the 
Sv averaging time. Model 900 Analyzers only.

COS TAvg (sec)** 
This displays the factory-set compensation value (in seconds) for the 
COS averaging time. Model 900 Analyzers only.

CS2 TAvg (sec)** 
This displays the factory-set compensation value (in seconds) for the 
CS2 averaging time. Model 900 Analyzers only.

Temp Comp Coef** 
This displays the factory-set temperature compensation coefficient 
value for SO2 cross-interference correction.
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Analog Inputs

The Analog Inputs dialog box allows you to configure various parameters 
for the analog inputs associated with the analyzer.


NOTE

‘**’ following the parameter names below indicates the parameter 
should only be modified by a trained technician.

Analog Input Measurement Parameters** (factory-set) 
Allows you to assign analog inputs for measurements and set calibra-
tion parameters.

	 Channel Assignment	 Defines the signal assigned to each of the six 
analog channels.

	 TAvg (sec)	 This factory-set time period (in seconds) 
displays the averaging times of the compen-
sation functions.

	 Low	 Displays the factory-set offset low range.

	 High	 Displays the factory-set offset high range. 

	 Measurement	 Displays the signal levels. 

Figure 3-12. 
Analog Inputs dialog 
box.

Setup (tab)Analog 
Inputs
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	 The following signals are assigned to the Analog Input channels. 
Some signals are not applicable to (not used by) or optional for certain 
analyzers.

	 O2	 Allows you to enter a range (%). Factory-set. 
(Optional)

	 Cell Temp**	 Displays the real-time temperature for the 
Measuring Cell (°C or °F).

	 Cell Pres**	 Displays the real-time absolute pressure for 
the Measuring Cell (mmHg or "Hg). Factory-
set. Also used for factory calibration.

	 Stream Temp	 Displays a value for stream temperature 
(°C or °F). (Optional)

	 Stream Pres	 Displays a value for stream pressure  
(°C or °F). Factory-set.

	 Stream Velocity	 Displays a value for the external stream 
velocity.

	 Diff Pres	 Displays a value for the velocimeter  
(mmH2O or "H2O). Factory-set. Also used 
for factory calibration.

	 Probe Temp	 Displays a value for the probe temperature 
(°C or °F). Factory-set. Also used for factory 
calibration.

	 Volu Flow Rate	 Displays a value for the external volumetric 
flow rate. (Optional)

	 Apply button	 Applies the changes you made to these 
values.

Raw 
Displays a value that has been digitally converted from an analog 
input measurement.
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O2 Measurement Parameters 
Lists various O2 configuration and calibration parameters used to cali-
brate the O2 Sensor.

	 Spec 	 Factory-set value.

	 Zero CalOffset (%)	 Zero offset is a factory-set calculated value 
that is adjusted based on the average read-
ing during the last 25 percent of the AZ-0 
timer (Timer0) duration.

	 SFactor 	 Span factor is a factory-set calculated cali-
bration value. 

	 Span 	 Factory-set value to which the O2 concentra-
tion analyzer will be spanned.

	 Air Point	 Factory-set value to which the O2 concentra-
tion analyzer is zeroed. (Air is used to obtain 
the air reference point which establishes the 
O2 Sensor zero point.)

	 Z-Sol#	 This is a factory-set value for the Zero 
Solenoid.

	 S-Sol#	 This is a factory-set value for the Span 
Solenoid.

	 Apply button	 Applies the changes you made to these 
values.

	 Normal button	 Toggles the analyzer to normal operation 
when zero or span is active. The message 
box beside this button displays the opera-
tional status (On or Off) of the analyzer.

	 Zero button	 This factory calibration function toggles the 
Zero solenoid on to zero the O2 Sensor. The 
message box beside this button displays the 
status (On or Off) of the Zero solenoid.

	 Span button	 This factory calibration function toggles the 
Span solenoid on to span the O2 Sensor. The 
message box beside this button displays the 
status (On or Off) of the Span solenoid.
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Velocimeter 
Lists various configuration parameters used to measure the velocity of 
the measured gas species. Model 909, 910 Analyzers only.

	 Flow Control	 Lists the analyzer’s current flow control 
mode. 
0 = analyzer control 
1 = continuous backpurge

	 TPurge Time (sec)	 Displays the duration (seconds) of the Pitot 
tube backpurge. The delay period can be 
set from 0–255 in one-second increments. 
Setting the duration to zero (‘0’) disables the 
function.

	 TPurge Delay (sec)	 Displays the delay (seconds) following the 
backpurge in which the system will wait 
before resuming operation. The duration 
can be set from 0–120 in one-second incre-
ments, depending on sample line length. 
Setting the duration to zero (‘0’) disables the 
function.

	 VelpgIntvl (min)	 Displays the time interval (minutes) be-
tween the Pitot tube backpurge sequences. 
The interval can be set from 0–255 in one-
minute increments. Setting the interval to 
zero (‘0’) disables the function.

	 Diff Pressure (min)	 Allows you to set up the differential pres-
sure parameters.

		  Z-Offset 
Displays the differential pressure transducer 
zero offset calibration value.

		  SFactor 
Displays the differential pressure transducer 
span factor calculated calibration value. 

	 Apply button	 Applies the changes you made to these 
values.
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	 Normal button	 Toggles the analyzer to normal operation 
when the velocimeter function is active. The 
message box beside this button displays the 
operation status (On or Off) of the analyzer.

	 Zero button	 This function toggles the Zero solenoid on 
during velocimeter functions. The message 
box beside this button displays the status 
(On or Off) of the Zero solenoid.

	 Span button	 This function toggles the Span solenoid on 
during velocimeter functions. The message 
box beside this button displays the status 
(On or Off) of the Span solenoid.

	 Bk Purge button	 This function toggles the Backpurge func-
tion Off-On. The message box beside this 
button displays the status (On or Off) of the 
Backpurge function.

	 Kq	 Displays the constant for the volume-flow-
rate calculation based on process stream 
data, process duct physical data, and units 
of measurement.

Stream Velocity

	 XArea	 Cross area value.

	 Kv	 The K(v) value is the molar absorptivity of 
the species of interest at the wavelengths 
used.

Stream Temp Coef** 
Displays the factory-set coefficients calculated to linearize the reading 
from the process stream temperature transducer. Do not change these 
values.
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Probe Blowback 
Allows you to enter values that define the operational characteristics 
of the Probe Blowback device.

	 Interval	 Allows you to enter the interval-time be-
tween blow-backs, in minutes. When an 
interval-time is entered, it is displayed along 
with a countdown timer (time remaining 
until the next blow-back).

	 Duration	 Allows you to enter a value that defines the 
duration of each blow-back, in seconds.

	 Pulse	 Is the Probe Blow-Back Pulse Width param-
eter. This parameter allows you to enter 
the length of time (in seconds) the analyzer 
will allow the blow-back system to build up 
pressure between pulses (air bursts, which 
blow debris back into the stack).

	 Normal button	 Toggles the Probe Blowback device Off-On 
for normal conditions. The message box 
beside this button displays the operation 
status (On or Off) of the analyzer.

	 Blow Back button	 Toggles the Probe Blowback function Off-
On. The message box beside this button 
displays the operation status (On or Off) of 
the Probe Blowback function.

	 Apply button	 Applies the changes you made to the Stream 
Velocity, Stream Temp Coef, and Probe 
Blowback values.

Refresh button 
Reverts the changes you made on this screen back to their original set-
tings, but only before you click OK to exit this screen. 
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Setting Gas Calibration Parameters

The Gas Calibration dialog box contains gas species information and 
sample system control parameters.

Analyzers with Dual Range functionality (e.g., so2 = Low Range; 
SO2 = High Range) must be configured from the User Interface 
Panel, as certain parameters are not available in the System 200 
Configuration Software.

Result Code 
Each of these factory-set Result Codes corresponds to a specific spe-
cies. Result Codes are used to define outputs.

Species 
Displays the names of available, factory-set gas species/output settings.

Span 
This is the concentration of the component (ppm or %) in the calibra-
tion gas mixture. The concentration is entered in decimal notation. 
The maximum concentration which can be entered is 999 999. If a 
calibration gas is not used, this value must be set to zero (‘0’).

If the span gas concentration is changed to a value greater than 32700 
ppm (or 32.7 %) using the Configurator Software, the analyzer mem-
ory (as viewed from the analyzer User Interface Panel, CAL: F4 1) 
will not be updated with the correct value.  
 
This problem can also occur if changing the concentration unit from ppm 
to %, or % to ppm, if the value is greater than 32700 ppm (or 32.7 %). 
 
Therefore, if the span gas concentration must be changed to a value 
greater than these, or from ppm to % or % to ppm, make the change 
from the User Interface Panel.


NOTE

Figure 3-13. 
Gas Calibration dialog 
box.


NOTE

Setup (tab)Gas 
Calibration
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SFactor 
The Span (calibration) Factor for the calculated result (component con-
centration) for each configured gas species (and NOx, if applicable). The 
analyzer’s Span Factor is adjusted automatically whenever the analyzer is 
Spanned if the Calibration Adjustment check box is checked (enabled).

ZCalDrift 
The Zero Calibration Drift specification is used only when the Calibration 
Adjustment check box is checked. At the end of every Auto-Zero or Manual Zero, 
the zero drift result is calculated and displayed (in PPM).

SCalDrift 
The Span Calibration Drift specification is used only when the 
Calibration Adjustment check box is enabled. At the end of every 
span, the span drift result is calculated and displayed (in PPM).

Solenoid # 
The Solenoid parameter assigns an SSR output controlling a calibration 
gas solenoid valve to a calculated result. The same SSR output can be 
assigned to more than one calculated result. This permits a multi-com-
ponent calibration gas to be used. If a calibration gas is not used with 
one of the calculated results the value for the SSR output must be set to 
zero (‘0’).

Manual CAL 
This group includes the control options that allow you to perform 
manual calibration functions on the analyzer.

Man Span buttons	 Allow the user to manually span the 
analyzer for each component. The ana-
lyzer calibration is automatically adjusted 
based on the average reading during the 
Integration Timer period after clicking the 
corresponding ManSpan button, but only 
if the Calibration Adjustment check box is 
checked. The span gas must be introduced 
manually using the Flow Control function.

ManZero button	 Allow the user to manually zero the analyz-
er. The analyzer zero is automatically adjust-
ed based on the average reading during the 
Integration Timer period after clicking the 
ManZero button, but only if the Calibration 
Adjustment check box is checked. The zero 
gas must be introduced manually using the 
Flow Control function.

SO2 Xtalk Reduction button 
Recalculates the matrix elements for Sv and 
NDR at specific wavelengths to reduce SO2 
cross-talk. Model 900 Analyzers only.
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Auto CAL

AutoCAL button	 Initializes the analyzer to automatically 
cycle sequentially through the Auto-Zero 
and Auto-Span functions. Only the func-
tions with timers set to non-zero durations 
are included.

	 The zero offset and calibration will be au-
tomatically adjusted only if the Calibration 
Adjustment check box is checked.

AutoZero button	 Initializes the analyzer to automatically 
introduce Zero gas into the sample system. 
The Zero gas solenoid is turned on and off 
automatically during the sequence.

	 The zero offset is a factory-set calculated 
value that is adjusted based on the average 
reading during the last 25 percent of the 
AZ-0 timer (Timer0) duration.

An Auto-Zero sequence initiated on a timed basis or by a remote con-
tact will not be executed if there is a fault alarm present.

AutoSpan buttons 
Automatically introduce calibration gas 
into the sample system. The calibration gas 
solenoid valve connected to the SSR output 
(1, 2, or 3) is turned on and off automatically 
during the sequence.

	 The analyzer calibration is automatically ad-
justed based on the average reading during 
the last 25 percent of the countdown after 
clicking the appropriate AutoSpan but-
ton, but only if the Calibration Adjustment 
check box is checked.

	 For multi-component calibration gas mix-
tures, the same solenoid can be assigned 
to different species, but must be spanned 
individually.

Cancel Calibration button 
Aborts the calibration sequence (Manual 
Zero, Auto-Zero, Span).


NOTE
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Calibration Timers 
Allows you to set up the timers used during calibration.

Manual Calibration	 Allows you to enter a time value (Default = 
60 seconds) for the Integration Timer(sec), 
during which the concentration reading 
for each of the species is averaged. The 
Integration Timer may be set to a dura-
tion from 0–65535 seconds in one-second 
increments.

Sample Delay (min)	 Allows you to enter a time value (in min-
utes) that sets the time delay for the AUTO/
MANUAL relay to continue indicating that a 
calibration (Zero) is in progress after com-
pletion of the Zero function. This function 
also sets the time delay that the Normal/
Fault relay will wait before indicating the 
fault alarm has been cleared. This allows for 
a smooth transition from the Zero/Span Gas 
back to the sample gas. The delay can be set 
from 0–255 minutes in one-minute incre-
ments. Setting the delay to zero (‘0’) turns 
the function off.

Auto Calibration Timers 
Allow you to enter a time value (in minutes) for the Auto-Zero Timer 
and three Auto-Span Timers.

AZ-0	 Allows you to enter a value (duration) that 
defines the amount of time that the zero 
solenoid is active during an Auto-Zero func-
tion. The time may be set from 0–255 min-
utes in one-minute increments. Setting the 
time to zero (‘0’) turns the timer off.

AS-1, AS-2, AS-3	 Allows you to enter a value (duration) that 
defines the amount of time that each of the 
three span solenoids is active during an 
Auto-Span function. The time may be set 
from 0–255 minutes (default = 4 minutes) in 
one-minute increments. Setting these timers 
to zero (‘0’) to turn them off.
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AZero Interval	 The Auto-Zero Interval Timer field allows 
you to enter a time value (in hours) that 
controls the interval between Auto-Zero 
sequences. The interval can be set from  
0–999 hours in one-hour increments. Setting 
the interval to zero (‘0’) turns the timer off, 
disabling a timed start of the Auto-Zero 
sequence.

	 The Auto-Zero function will be included in 
the Auto-Calibration sequence if Auto-Zero 
is enabled and Timer0 duration is not zero.

ACAL Interval	 The Auto-Calibration Timer allows you to 
enter a time value (in hours) that controls 
the interval between Auto-Calibration se-
quences. The interval can be set from  
0–999 hours in one-hour increments (de-
fault = 0 hours). Setting the interval to zero 
(‘0’) turns the timer off, disabling a timed 
start of the Auto-Calibration Zero sequence.

Calibration Adjustment Enable 
Enables or disables the automatic adjustment of the analyzer zero off-
set and calibration for all Zero and Span operating modes. When the 
automatic adjustment is disabled, all auto-calibration functions (Auto-
Zero, Auto-Span, or Auto-Calibration) – except automatic calibration 
adjustments – will be performed. (i.e., Zero gas or Calibration Gas will 
be introduced into the sample system but no automatic adjustment 
will be done).

Checked	 Automatic calibration adjustment will 
be performed after an Auto-Calibration 
sequence.

Not Checked	 Automatic calibration adjustment will not 
be performed after an Auto-Calibration 
sequence.
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Display 
These message lines display the same information as that currently 
being displayed on the analyzer User Interface Panel.

	 During normal operation, these message lines display the real-time 
status of the species being measured (top line) and its concentration 
value (bottom line).

	 When an Auto-Setup is in progress, messages indicating the current 
stage of the Auto-Setup are displayed on the top line. Auto-Setup mes-
sages include:

•	 Adjusting PMT Level
•	 Adjusting Lamp Pulses
•	 Adjusting PMT Balance
•	 Adjusting PMT Level
•	 Adjusting Lamp Pulses
•	 Setting Up ALC
•	 Off/Completed

	 This information is also displayed on other screens.

	 Green text = normal conditions. 
Red text = Warning or Fault alarm active. 
 
If an alarm is active, refer to the analyzer manual (“Maintenance and 
Troubleshooting” chapter) for details about the alarm and corrective 
action to take to reset the alarm.

Flow Control 
This is the analyzer sample gas flow control mode. For normal op-
erations, the analyzer operates in the Analyzer Control (automatic) 
mode. Other Flow Control modes are set manually by the user.

	 The Flow Control modes, listed in the Flow Control Legend, vary for 
different analyzers. The analyzer will operate in the corresponding 
Flow Control mode code that is entered in the Flow Control Mode 
box below the Flow Control Legend. After entering a Flow Control 
mode code, click the Apply button to save the change and set the ana-
lyzer into the new Flow Control mode.

Depending on the analyzer you are working with, certain Flow 
Control modes listed below may not be available. Only the Flow 
Control modes available for the analyzer you are working with are 
displayed in the software. Some Flow Control mode descriptions are 
slightly different from analyzer to analyzer.


NOTE
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	 0 = analyzer control 
Enter this code to enable the analyzer to automatically determine and 
set the mode of operation (sample or backpurge) by monitoring the 
state of the Fault alarm relay contacts.

	 1 = continuous backpurge/zero flow 
or 
1 = continuous backpurge 
Enter this code to manually force the analyzer to continuously back-
purge its sample system with Zero (or Instrument Air) gas.

	 2 = continuous sample flow 
or 
2 = continuous sampling 
Enter this code to manually force the analyzer to continuously extract 
sample gas from the process duct and force it throughout its sample 
system.

	 10 = continuous zero (probe-tip) 
or 
10 = zero gas flow 
Enter this code to manually force the analyzer to continuously back-
purge its sample system with Zero gas.

	 11 = continuous cal gas1 (probe-tip) 
or 
11 = cal gas1 flow 
Enter this code to manually force the flow of Calibration Gas 1 
through the analyzer’s sample system.

	 12 = continuous cal gas2 (probe-tip) 
or 
12 = cal gas2 flow 
Enter this code to manually force the flow of Calibration Gas 2 
through the analyzer’s sample system.

	 13 = cal gas3 flow 
Enter this code to manually force the flow of Calibration Gas 3 
through the analyzer’s sample system.
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Analyzer Information

The Info dialog box displays information about the analyzer and al-
lows you to reset the analyzer’s Host Controller board and enter or 
change passwords that are used to access the CALibration (CAL) and 
ConFiGuration (CFG) mode passwords.

Host Version 
Displays Host Controller board software version.

Micro Version 
Displays Microcontroller board software version.

Serial # 
Displays analyzer serial number.

EEPROM Writes 
Displays number of times that new configuration data has been saved 
to the analyzer’s EEPROM. The maximum allowable number of saves 
is 20,000.

Password Protection

Back to Run Mode button 
Allows you to revert the software back to RUN mode if passwords 
have been entered to access CAL and/or CFG Modes. This will 
ensure no further changes can made to parameter settings.

	 Click this button after a successful Auto-Setup to return the ana-
lyzer to RUN mode.

Figure 3-14. 
Analyzer Information 
dialog box.

Setup (tab)Analyzer 
Info
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Enter CAL mode password here: 
Used to enter the Calibration mode password, which is required to 
change Calibration parameters.

Enter CFG mode password here: 
Used to enter the Configuration mode password, which is re-
quired to change Configuration parameters.

Password Update 
A password is required to change the Calibration and 
Configuration mode passwords.

Enter Password	 Enter the password that allows you to 
change the CAL and CFG mode passwords.

Update button	 Saves the new password that allows you to 
change the CAL and CFG mode passwords.

Serial Number Update 
Used by factory personnel to enter a serial number for the analyzer. 
Do not change this.

Model ID 
Displays a code (see Analyzer Code Legend, below) that the software 
uses to define the AMETEK analyzer model the software is currently 
communicating with (do not change this). Analyzer models include:

	 144 = M900 (Model 900 Analyzer) 
145 = M910 (Model 910 Analyzer) 
146 = M920 (Model 920 Analyzer) 
147 = (Reserved) 
148 = (Reserved) 
149 = M909 (Model 909 Analyzer) 
150 = M919 (Model 919 Analyzer)

Refresh button 
Reverts any values that you have modified back to their original set-
tings, but only before you select an Update button or OK. When you 
click this button, any values that you have changed but do not wish to 
set permanently will revert to the settings that were last saved to the 
system’s EEPROM.

The factory-default 
password is ‘• •’ for both CAL 
and CFG modes.

To change the factory-
default CAL / CFG mode 
passwords, contact AMETEK 
or your IT Administrator.
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HC Reset button 
Resets the analyzer’s Host Controller board.

Do not randomly reset the analyzer during normal operation. 
Typically, the only resets required are in cases where the Host 
Controller or Microcontroller boards have been replaced. In this 
case, it is necessary to shut down the analyzer. The analyzer will reset 
upon normal power-up.

Display 
These message lines display the same information as that currently 
being displayed on the analyzer User Interface Panel.

	 During normal operation, these message lines display the real-time 
status of the species being measured (top line) and its concentration 
value (bottom line).

	 When an Auto-Setup is in progress, messages indicating the current 
stage of the Auto-Setup are displayed on the top line. Auto-Setup mes-
sages include:

•	 Adjusting PMT Level
•	 Adjusting Lamp Pulses
•	 Adjusting PMT Balance
•	 Adjusting PMT Level
•	 Adjusting Lamp Pulses
•	 Setting Up ALC
•	 Off/Completed

	 This information is also displayed on other screens.

	 Green text = normal conditions. 
Red text = Warning or Fault alarm active. 
 
If an alarm is active, refer to the analyzer manual (“Maintenance and 
Troubleshooting” chapter) for details about the alarm and corrective 
action to take to reset the alarm.

!
CAUTION
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VIEWING LIVE DATA

Similar to RUN mode while working from the analyzer User Interface 
Panel, you can view live analyzer results and operational status without 
having to enter a password.

Status Tab

The Status tab displays live data results of the selected outputs, plus the 
Fault and Warning conditions (current and historical) associated with the 
HC Scode (Host Controller Status Code) and MC Scode (Microcontroller 
Status Code). You can also view the current status of various ana-
lyzer control functions from this tab. This screen is particularly useful 
when performing analyzer diagnostics. Information on this tab is not 
user-adjustable.

Figure 4-1. 
Status tab.

Analyzer Status
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System Status Messages along the top portion of this screen display in-
formation about the System 200 Configurator Software and the ana-
lyzer. These include:

Analyzer Status 
Displays the communication status between the System 200 
Configurator Software and the analyzer. Messages that can appear 
here include: OFFLINE, Online, DISABLED, Device Not Found, 
or DEMO Online. Their descriptions are listed in Chapter 1.

Host Runtime 
This is the amount of time the Host Controller board has been 
performing controls since the analyzer was last powered up or 
reset.

Micro Runtime 
Amount of time the Microcontroller board has been performing 
controls since the analyzer was last powered up or reset.

Host Controller Board software version 
Displayed next to Host Runtime (e.g., HCADA e V4.00). This 
information will be displayed only if the System 200 Configurator 
Software is communicating with the analyzer.

Microcontroller Board software version 
Displayed next to Micro Runtime (i.e., MC900e V5.52). This in-
formation will be displayed only if the System 200 Configurator 
Software is communicating with the analyzer.

SN# 
Analyzer’s serial number. This information will be displayed only 
if the System 200 Configurator Software is communicating with 
the analyzer.

HC Scode 
Displays active alarm conditions that originate from the Host 
Controller board. Each alarm condition is preceded by its status num-
ber, followed by the type of alarm (Fault or Warning), and the alarm 
description. The sum of their respective primary codes is listed in the 
field next to HC Scode.

For a complete list of alarms generated by the Host Controller board, 
refer to the analyzer manual for the analyzer you are working with.


NOTE
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MC Scode 
Displays active alarm conditions that originate from the 
Microcontroller board. Each alarm condition is preceded by its status 
number, followed by the type of alarm (Fault or Warning), and the 
alarm description. The sum of their respective primary codes is listed 
in the field next to MC Scode.

For a complete list of alarms generated by the Microcontroller board, 
refer to the analyzer manual for the analyzer you are working with.

History 
These readings are history buffers for the Host Controller (HC Scode) 
and Microcontroller (MC Scode) boards, for the last eight measuring 
cycles. Each history buffer displays a status code (if any alarms have 
been set), which is a sum of the primary error codes, where ‘1’ is the 
oldest status code and ‘9’ is the most recent. To resolve a non-primary 
status code into its primary error codes, subtract the largest primary 
error code from the displayed number. Continue to subtract the 
largest primary code from the remainder until a primary error code 
remains.

Calculated Results 
Located to the right of the HC Scode and MC Scode History buffers, 
the existing results and values are displayed. The value for each result 
will be displayed and updated at one-second intervals.

	 The calculated results displayed include:

Conc	 Displays the current concentration for each component 
displayed to the left of this column.

O2 Corr	 Displays the current O2 Corrected concentration for 
each component displayed to the left of the Conc 
column.

Emission	 Displays the current Emission levels for each compo-
nent displayed to the left of the Conc column.

Solenoid Status 
Displays the current status of the purge solenoid, either Purging 
(Model 900 Analyzers only), Zeroing, Sampling, or OFF.

Wheel Speed (rpm) 
The current optical bench filter wheel speed in revolutions per minute 
(RPM).


NOTE
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Remote ACal 
The current status of the remote, dry (potential free) contact, either 
start (closed) or OFF (open). When start is displayed, the remote auto-
calibration function has been initiated from a remote control room, 
such as a Data Acquisition System (DAS).

Over Temp Trip 
The current status of the Over Temperature circuit, either Tripped 
or Normal. The Tripped status indicates that one of the Over-Temp 
RTDs has exceeded its trip-point value. This action will trip the Over 
Temperature circuit and will set a High Temperature alarm. The Over 
Temperature circuit can only be reset by manually resetting the SW300 
switch on the Termination board. The Over Temperature trip-point 
value is not user-adjustable.

Auto/Man Relay 
Model 900, 930 Analyzers: 
When the analyzer is operating in its normal Automatic state, the 
Auto/Manual relay is energized. If this relay is in the Manual (de-
energized) state, either a fault alarm condition exists within the ana-
lyzer’s built-in diagnostics (analyzer service is required), the analyzer 
is operating in CALibration (CAL) or ConFiGuration (CFG) mode, an 
Auto-Zero has been initialized, or the analyzer’s Flow Control mode 
has been manually forced to Continuous Backpurge/Zero Flow mode 
or Continuous Sample mode. While in the Automatic state (by the 
analyzer), a lower case “m” is displayed in the top-left corner of the 
Display message lines on the Optical Bench, Gas Calibration, and 
Info dialog boxes and Status tab. It will also be displayed in the same 
location in Run mode on the User Interface Panel.

	 Resetting of the contacts is delayed by the Sample Delay Timer 
(SDelay) duration; otherwise, this relay’s contacts reset automatically 
upon correction of the fault alarm, upon switching back to Analyzer 
Control (automatic) mode, upon completion of the Auto-Zero func-
tion, or upon exiting CAL or CFG mode.

	 If no fault alarm conditions exist, you can manually change the state of 
this relay using the keypad command F2 • while working from RUN 
mode (this can only be done from the User Interface Panel). When this 
command is entered, an upper case “M” will be displayed in the top-
left corner of the RUN mode screen to indicate that the state of this 
relay has been changed manually by the user. This command will also 
cause the Run/Attention relay contacts to de-energize.
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Cal Relay 
Model 909, 910, 919, 920 Analyzers: 
The current status of the Run/Calibration relay. When the analyzer is 
operating in its normal Run state, this relay is energized. When any of 
the gas calibration functions are in progress, this relay is de-energized.  
 
Resetting of the contacts is delayed by the Sample Delay Timer 
(SDelay) duration.

Attn Relay 
When the analyzer is operating in its normal Run state, the Run/
Attention relay is energized. This relay is de-energized if a warning 
alarm condition exists within the analyzer’s built-in diagnostic system 
(the analyzer requires attention), or when the analyzer is operating in 
CFG or CAL mode. This indicates to the control room that the analyz-
er is not operating in its normal Run state. The Run/Attention contacts 
will also become de-energized if you manually force the analyzer’s 
Flow Control mode to any mode other than Analyzer Control (auto-
matic) mode.

	 When this relay changes state to de-energized, a lower case “m” will 
be displayed in the top-left corner of the Display message lines on the 
Optical Bench, Gas Calibration, and Info dialog boxes and Status tab. 
It will also be displayed in the same location in Run mode on the User 
Interface Panel.

	 Resetting of the contacts is delayed by the Sample Delay Timer 
(SDelay) duration; otherwise, this relay’s contacts reset automati-
cally upon correction of the warning alarm, upon switching back to 
Analyzer Control (automatic) mode, and/or upon exiting CFG or CAL 
mode.
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Fault Relay (Model 900, 930 Analyzers) or
Normal/Fault Relay (Model 909, 910, 919, 920 Analyzers): 

When the analyzer is operating in its normal Run state, the Normal/
Fault relay is energized. This relay is de-energized if a fault alarm 
condition exists within the analyzer’s built-in diagnostic system (the 

analyzer requires service). In RUN mode,    is displayed on the 
upper-right line of the User Interface Panel to indicate this relay has 
become de-energized.

	 With the exception of an Over-Temperature fault (f Temp High) – 
detected by the Temperature RTD Daughter boards – on the Sample 
Line, Vent Line (if used; or SCU), or Analyzer Oven, this relay’s 
contacts reset automatically upon correction of the fault alarm. The 
Over-Temperature fault, however, must be reset manually. To reset this 
relay, you must press SW300 on the Termination board, located in the 
Electronics Enclosure.

	 When a fault alarm condition exists (relay is de-energized), the sample 
system will automatically switch to Backpurge mode if the analyzer’s 
Flow Control mode is set to Analyzer Control (automatic) mode. 
For Model 900, 930 Analyzers only, a lower case “b” will be displayed 
in the top-left corner of the Display message lines (on the Optical 
Bench, Gas Calibration, and Info dialog boxes and Status tab) to in-
dicate the analyzer has automatically forced its Flow Control mode to 
Backpurge. It will also be displayed in the same location in RUN mode 
on the User Interface Panel.

To back out of this screen or to view or set up other system informa-
tion, choose another tab. Clicking OK or Cancel will take you back to 
the Configurator Software main window. You will have to re-establish 
computer-analyzer communications (select Device Properties from 
the Edit menu).


NOTE
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Display 
These message lines display the same information as that currently 
being displayed on the analyzer User Interface Panel.

	 During normal operation, these message lines display the real-time 
status of the species being measured (top line) and its concentration 
value (bottom line).

	 When an Auto-Setup is in progress, messages indicating the current 
stage of the Auto-Setup are displayed on the top line. Auto-Setup mes-
sages include:

•	 Adjusting PMT Level
•	 Adjusting Lamp Pulses
•	 Adjusting PMT Balance
•	 Adjusting PMT Level
•	 Adjusting Lamp Pulses
•	 Setting Up ALC
•	 Off/Completed

	 This information is also displayed on other screens.

	 Green text = normal conditions. 
Red text = Warning or Fault alarm active. 
 
If an alarm is active, refer to the analyzer manual (“Maintenance and 
Troubleshooting” chapter) for details about the alarm and corrective 
action to take to reset the alarm.
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Analyzer Data Tab

The Analyzer Data tab displays live data results of up to six species of 
gases plus other components, depending on which model of analyzer 
you are working with. You can also view live data results of each tem-
perature zone, analog inputs/outputs, and digital inputs/outputs. This 
screen is particularly useful when performing diagnostics on the analyzer. 
Information on this tab is not user-adjustable.

Results 
Displays the real-time calculated result of each species of gas being 
measured (up to six), plus live results of other components, such as 
Air Demand and Trend (Model 900/930 Analyzers), Flow Rate (Model 
909/910/919/920 Analyzers), O2  (Model 909/910/919/920 Analyzers), 
and NOx (Model 910/920 Analyzers). The results, which will vary 
from analyzer to analyzer, are updated at one second intervals. The 
appropriate results for the analyzer you are communicating with will 
be displayed on this screen. Review this screen to determine which 
results are displayed here.

Figure 4-2. 
Analyzer Data tab 
(multi-species 
analyzers).
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Temperature Zones 
Some zones are not applicable to (or are not used by) certain analyzers. 
Displays the real time Temperature (°C or °F) and Duty Cycle (%) of 
each temperature zone:

•	 S/L (Sample Line)

•	 V/L (Vent Line) or SCU (Sample Conditioning Unit)

•	 SKO (Sulfur Knock-Out) or optionally, SCU (Sample Conditioning 
Unit)

•	 Cell (Measuring Cell)

•	 Probe (AMETEK ASR900 Probe or Heated Acid Gas Probe)

•	 Heater (Oven Heater)

•	 Bench (Optical Bench)

Analog Outputs 
Displays the assigned analog output name (up to four) and its real 
time status. If no output is assigned to a channel, “none” will be 
displayed next to the channel number (for example, “4 – none”). The 
outputs will be different for each analyzer/application.

I - Output	 Displays the analog output (current).

Analog Inputs 
Displays the assigned analog input name (up to eight) and its real 
time status. If no input is assigned to a channel, no information is dis-
played. The inputs will be different for each analyzer/application.

Ch #	 Defines the input code assigned to each analog input 
channel.

Raw	 Displays the real-time digitally converted analog input 
values.

Digital IO 
Displays the real time status of the digital inputs/outputs.

DIN	 Displays the real time status (start or normal) of the digi-
tal input 2 (Remote Auto-Cal Contact). Note that digital 
input 1 is Not Available (N/A). The current status of the 
digital input is also displayed (1 = On; 0 = Off).

Relay	 Displays the real time status of the analyzer’s Auto-
Man Relay (Auto/Manual), Attn Relay (Run/Attention 
Status relay), and Fault Relay (Normal/Fault Status 
relay). The status is either Off (normal) or On (tripped).



4-10   |   Model 9xx-Series Analyzers System 200 Configurator Software

Solenoid Control Bits	 
Displays the real time status of the solenoids. Solenoids 9, 10, 12, 13 are 
pseudo solenoids. Refer to the analyzer manual for details.

To back out of this screen or to view or set up other system informa-
tion, choose another tab. Clicking OK or Cancel will take you back to 
the Configurator Software main window. You will have to re-establish 
computer-analyzer communications (select Device Properties from 
the Edit menu).


NOTE
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Optical Bench Data Tab

The Optical Bench Data tab (Figure 4-3, multi-species analyzers; Figure 
4-4, single-species analyzers) allows you to view live data results from 
various signals that originate from each of the filters in the Optical Bench. 
This dialog box is particularly useful when performing diagnostics on the 
analyzer. Information on this tab is not user-adjustable.

Figure 4-3. 
Optical Bench Data 
tab (multi-species 
analyzers).

Figure 4-4. 
Optical Bench Data 
tab (single-species 
analyzers).
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ALC Lamp Pulse (mV) 
Displays the real time lamp pulse measurement of the Automatic 
Lamp Control function, for each Filter location.

PMT Measure (mV) 
Displays the real time value of the Photomultiplier Tube Measure volt-
age, for each Filter location.

PMT Reference (mV) 
Displays the real time value of the Photomultiplier Tube Reference volt-
age, for each Filter location.

Absorbance 
Displays the real time absorbance values for each Filter location.

Transmittance 
Displays the real time transmittance values for each Filter location.

Tzero 
Displays the real time PMT signal transmittance, for each Filter loca-
tion, with Zero gas in the sample system. It is adjusted automatically 
whenever the analyzer is Zeroed.

To back out of this screen or to view or set up other system informa-
tion, choose another tab. Clicking OK or Cancel will take you back to 
the Configurator Software main window. You will have to re-establish 
computer-analyzer communications (select Device Properties from 
the Edit menu).

Signal 3 
Analyzer Models 909, 919 only (single-species). 
Displays the real time baseline measurement of the Measure and 
Reference PMT signals in an off-state.


NOTE
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MODES OF OPERATION

Any settings you define for a mode will be retained by the system when 
you change the mode or exit the program. 

Any display or scan parameters that you define for a mode will not be 
transferred to a new mode when you switch modes. However, the system 
will continue to scan when you change modes.

Meter Mode

Meter mode allows you to view information in a meter-type format 
(Figure 5-1). Alarms can be set up and displayed on the meter to view the 
current reading in relation to the High and Low alarm limits defined. You 
can also define unique scan, display, and alarm output settings.

To set up a Meter mode display:

1.	 Select Meter from the Mode menu or click    from the Standard 
Toolbar.

2.	 Select a meter by clicking on one. A yellow border around the meter 
indicates it is active.

3.	 Right-click the active meter and define the Scan, Display, and/or 
Alarm settings for the meter.

4.	 Repeat Steps 2 and 3 to add more meters.
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While working in Meter mode:

•	 Each meter has a bar representing a measured value. Text under the 
meter displays the numeric value of the measured parameter.

•	 Each meter can be set to display alarm limits. As long as the measured 
value is within the high and low alarm limits, the meter bar appears in 
green.

	 A yellow meter bar indicates an alarm Warning condition.

	 A red meter bar indicates an alarm Fault condition.

•	 Any other actions associated with alarms are activated if the limit is 
exceeded (e.g., running an information file, or setting off a digital or 
analog output).

•	 Before changing meter properties, you must select the meter by click-
ing on it. The meter will be highlighted with a yellow border when 
selected.

Figure 5-1. 
Meter mode display.
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Annunciator Mode

Annunciator mode (Figure 5-2) allows you to track whether a measured 
parameter is within acceptable user-defined limits using a simple color/
text indication.

If the level is:

	 WITHIN the alarm limits defined 	 = 	 GREEN	 =	 OK
	 ABOVE the High alarm warning level	 = 	 YELLOW	 =	 HIGH
	 ABOVE the High alarm limit 	 = 	 RED	 =	 HIGH
	 BELOW the Low alarm warning level 	 = 	 YELLOW 	 =	 LOW
	 BELOW the Low alarm limit 	 = 	 RED	 =	 LOW

	 You can set up multiple indicators, each corresponding to a different 
gas species. You can also define unique scan, display, and alarm out-
put settings.

To set up an Annunciator mode display:

1.	 Select Annunciator from the Mode menu or click    from the 
Standard Toolbar.

2.	 Select a display by clicking on one. A yellow border around the dis-
play indicates it is active.

3.	 Right-click the active display and define the Scan, Display, and/or 
Alarm settings for the display.

4.	 Repeat Steps 2 and 3 to add more displays.

Figure 5-2. 
Annunciator mode 
display.
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While working Annunciator mode:

•	 Annunciator mode is normally used to define alarm limits so that 
you can view – using visual indicators – whether the selected value is 
within the alarm limits.

•	 For each channel, a green display indicates the value is within accept-
able limits.

	 A yellow display indicates an alarm warning.

	 A red display indicates an alarm condition.

•	 Before changing the display properties, you must select the display 
by clicking on it. The display will be highlighted with a yellow border 
when selected.
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Trend Mode

Trend mode allows you to view trends of measured parameters in a 
graphical format (Figure 5-3). You can also define unique scan, display, 
and alarm output settings.

To set up a Trend mode graph:

1.	 Select Trend from the Mode menu or click    from the Standard 
Toolbar.

2.	 Select a display by clicking on one. A yellow border around the dis-
play indicates it is active.

3.	 Right-click the graph and define the Scan, Display, and/or Alarm set-
tings for the graph.

While working in Trend mode:

•	 The main Trend mode window displays each channel as a colored 
line. The Y-axis displays partial pressure or measured value; the X-axis 
displays time.

•	 You can view the exact value of a trend line by holding down the left 
mouse button in the trend graphical display area. Display the Data 
File Toolbar to view the time of each data point.

Figure 5-3. 
Trend mode (graph) 
display.
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Tabular Mode

Tabular mode allows you to view information in a textual, table-type 
format (Figure 5-4). You can also define unique scan, display, and alarm 
output settings.

While working in Tabular mode:

•	 If an alarm was defined and the alarm has been exceeded, an alarm 
indicator will appear to the right of the main table.

•	 You can copy any of the columns from a Tabular display window 
to the clipboard. See also “Copying Magnitudes” and “Copying 
Channels” in Chapter 11 for more information.

•	 Before changing the display properties, you must select the display 
by clicking on it. The display will be highlighted with a yellow border 
when selected.

To set up the software for Tabular mode:

1.	 Select Tabular from the Mode menu or click    from the Standard 
Toolbar.

2.	 Select a display by clicking on one. A yellow border around the dis-
play indicates it is active.

3.	 Right-click the active display and define the Scan, Display, and/or 
Alarm settings for the display.

4.	 Repeat Steps 2 and 3 to add more displays.

Figure 5-4. 
Tabular mode display.
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Custom Modes

Custom mode allows you to create custom setups that can include all 
scanning, display, and alarm output options. This is done from the Set 
Custom Mode Menu dialog box (Figure 5-5). Custom mode setups can 
include either a single mode display window or multiple mode display 
windows. Using Custom mode, you can create a unique mode display by 
mixing and matching the best features of various modes.

For example, you can customize the window to show one Meter mode 
display window, one Trend mode window, and two Annunciator win-
dows. Or, you could set up two Trend mode display windows, or two 
Tabular mode windows.

Three default custom mode setups are included with the Configurator 
Software and more can be added as needed. For each display window 
added in Custom mode, the scanning, displays, and alarm output options 
are set as if in that mode.

For example, if adding a Meter mode window within the Custom mode, 
all settings for that window are defined as if in Meter mode. 

To create a Custom Mode:

1.	 Select New from the File menu or click    on the Standard Toolbar.

2.	 Select Add Display from the Edit menu and select the type of display 
you want to add from the list of standard mode types. Or, use the 
Custom mode icons on the Custom Mode Toolbar to add different 
displays.

3.	 Specify the data source. Select the applicable source of data from the 
Data Source group by clicking Device and then selecting the device 
you want to enable.

Figure 5-5. 
Set Custom Mode 
Menu dialog box.
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4.	 Repeat Steps 2 and 3 to add others displays, if desired.

5.	 Select Save As from the File menu to save the Custom mode. Or click 

one of the    icons on the Standard Toolbar to save the 
Custom mode to one of the predefined Custom mode file names (cus-
tom1.dyc, custom2.dyc, or custom3.dyc). Custom mode files are given 
a .dyc file extension.

6.	 To retrieve the Custom mode file at a later time, select Open 
Configuration from the File menu. If you used one of the predefined 
icons, double-click one of the files to retrieve it.

Moving or Resizing a Window in Custom Mode

Select the display window to move or resize. The window is highlighted 
with a yellow border.

•	 To move the window, press and hold down the mouse button (just an 
outline of the window is visible) while moving the display window, 
then release the mouse button.

•	 To resize the window, use standard Windows methods.

Figure 5-6. 
Custom Mode display, 
with Meter, Tabular, 
Annunciator (“Trend”), 
and Trend modes all 
in one.
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Adding a Display Window in Custom Mode

1.	 From the Edit menu, select Add Display. Choose the type of display 
window to add.

2.	 Select the data source for the display window.

3.	 The system adds a display window to the Custom mode window.

Deleting a Window in Custom Mode

1.	 Click on the window to be deleted. The window is highlighted with a 
yellow border.

2.	 Select Delete Display from the Edit menu, press the Del key on the 

keyboard, or click    from the Custom Mode Toolbar to delete the 
display window.

Saving Custom Mode Files

1.	 Select Save As from the File menu . You can save the Custom mode 
setup under a new name or use one of the predefined icons.

2.	 Select the Save button to save the file.

3.	 By default, the system places these files in the folder where the 
Configurator Software is installed and gives the file a .dyc extension.

If you save a Custom mode file in the install folder with the name “start-
up.dyc” it will automatically be opened when the program starts.

Opening Custom Mode Files

1.	 Select Open Configuration from the File menu or click    from the 
Standard Toolbar.

2.	 Navigate to the location of the Custom mode file to open.

3.	 Select the Custom mode file and click Open.
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Adding Custom Mode Files to the Mode Menu

1.	 Select Set Menu from the Mode menu to view the Set Custom Mode 
Menu dialog box (Figure 5-5). You can associate a Custom mode file to 
appear at the bottom of the Mode menu. 

	 You can also provide a menu/button name to appear instead of the file 
name at the bottom of the menu.

2.	 Navigate to the location of the Custom mode file using the Browse 
button.

3.	 To enter a name that will appear at the bottom of the Mode menu, 
enter a name in the Menu/Button Name text field.

4.	 To recall any of these files, click one of the    icons.
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SETTING PREFERENCES

The Preferences dialog box allows you to set up parameters that define 
how Tabular mode the files will be saved.

To set preferences, select Preferences from the Edit menu.

•	 DDE Item Separator
	 Select the character that will separate multiple data items in a 

Dynamic Data Exchange (DDE) message.

•	 Trend Colors
	 Set the default trend channel colors.

•	 Data file size
	 Set the maximum size for a data file. This can be an integer between 1 

and 16. The normal value is 1 megabyte. Setting the data file size to a 
higher value will increase the size of your data files as well as the size 
of the trend graph buffer. As a result of this increase, it will require 
more disk space and memory.

Figure 6-1. 
Preferences dialog 
box.
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SCANNING DATA

This chapter contains information on how to scan data and how to link 
data from a different display. Analyzer data that is scanned can be dis-
played on the screen in any of five formats (or modes) based on your ap-
plication. See Chapter 5 – Modes of Operation and Chapter 8 – Setting Up 
the Display for detailed information about setting up modes and defining 
their parameters.

Getting Started

A configuration file has been included with the Configuration 
Software.

From the File menu, select Open Configuration to open the 
DataLogSetup.dyc file. This should be in the same directory in which the 
Configurator Software has been installed. This configuration file sets up 
the software to display the:

•	 Trend graph of real-time concentration,

•	 Track and hold concentration (if used),

•	 Measure and reference PMT signals, and

•	 Analog inputs.

Once the file is open, click    on the Standard Toolbar to start scan-
ning data.


NOTE
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Defining Scan Settings

Define the type of information you want to gather from the selected de-
vice. To do this, right-click on the display window for the device you have 
selected and then click Scan from the context menu. The Properties dialog 
box appears with the Scan tab active.

For Trend and Tabular modes you must first select a channel before 
you can define scan settings. To do this, select a Channels button.

Data Source
	 Select the device from which to scan or temporarily disable the scan-

ning device.

•	 Disabled 
Select this option to disable the display of the selected channel.

•	 Device 
Select this option and use its list box to select the device from 
which to scan.


NOTE

Figure 7-1. 
Scan properties setup 
screen.
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•	 Link from 
Data can be linked from one window into another. This can save 
scanning time since the system only needs to scan the data one 
time. To do this:

1.	 Select the display window that will receive the linked data 
from another data source.

2.	 Right-click over the display window and then click Scan from 
the context menu that appears.

3.	 From the Data Source group, select the Link from button.

4.	 Select the data source to link from using the Link from list box.

Starting a Scan

To start a scan, click    or select Scan from the Control menu. The mes-
sage “Scanning” and the scanning progress will appear in the Status Bar 
at the bottom of the window (if it has been enabled).

If you have scheduled scans at timed intervals and the system has fin-
ished a scan and is waiting to start the next scan, the time remaining 
before the start of the next scan is displayed.

“Idle” is displayed in the Status Bar when the system is not scanning.

Stopping a Scan

Click    or select Scan from the Control menu to toggle off the scan.
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Scheduling Scans

Select Schedule from the Control menu or click    on the Standard 
Toolbar to view the Schedule dialog box.

Single Scan radio button 
Select this to command the software to run a single scan when you 

click   . The system will stop scanning after one scan.

Continuous radio button 
Select this to command the software to run scans at timed intervals 

when you click   .

Scan Interval text field 
Type a number to specify the time delay between scans. The unit this 
number represents depends on whether the scans were scheduled us-
ing seconds or minutes as the time interval.

Seconds	 Select this option to use seconds as the inter-
val between successive scans, as defined by 
the number specified in the Scan Interval 
text field.

Minutes	 Select this option to use minutes as the 
interval between successive scans, as de-
fined by the number specified in the Scan 
Interval text field.

Figure 7-2. 
Schedule Scan dialog 
box.
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SETTING UP THE DISPLAY

To set up the display for a mode, right-click on a display window and then 
click Display from the context menu that appears. The Properties dialog 
box is displayed, with the Display tab active. For modes using channels – 
Trend and Tabular modes – you must first select a channel before you can 
define the scan settings.

Figure 8-1. 
Display Properties 
dialog box.

Title 
Type the title for the display window. It will then appear in the title 
bar for that window and in other areas of the software to identify the 
display window.

Autoscale check box 
Applies to Meter mode only. When selected, the system automatically 
sets the Y-axis based on the highest value from the previous scan. This 
will also override the Y-axis. As the highest peak increases or decreas-
es, the display scale is changed to accommodate the changing highest 
peak.
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Logarithmic check box 
Applies to Trend and Meter modes only.

Checked	 The software uses a logarithmic scale to 
display readings.

Not Checked	 The software uses a linear scale to display 
readings. 

Upper limit 
Applies to Trend and Meter modes only. This value is used only when 
the Autoscale check box is not checked. Enter the upper limit to dis-
play on the Y-axis.

Lower limit 
Applies to Trend and Meter modes only. This value is used only when 
the Autoscale check box on the Display tab is not checked. If the 
Logarithmic check box is selected, use this text field to enter the num-
ber of logarithmic decades to display on the Y-axis using the upper 
limit as the top of the display range. If the Logarithmic is not checked, 
enter a value into this text box for the lower limit.

Units 
 This is the value in which your results will be displayed.

•	 In the Units text field, type in the units on which you want the 
scanned information displayed.

•	 Precision 
Defines the number of digits after the decimal point to be shown. 
For example, if the precision is set to 2, a reading might be 5.22.

Figure 8-2. 
Display Properties 
setup screen.
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Channel name 
Applies to Trend and Meter modes only. Names the displayed chan-
nel. Select one of the Channels buttons and enter a name for it in the 
Channel name text field.

Channel color 
Applies to Trend mode only. Defines a different color for the dis-
played channel. A custom color can also be chosen by clicking on the 
Custom button and selecting a color.

Minutes 
Applies to Trend mode only. Defines the time interval to include on 
the display.

Display Values 
If checked, displays channel values in Trend mode.

Hide check boxes 
Applies to Trend mode only. If checked, the data channel will not 
be displayed but will continue to track the data. This is useful when 
viewing a scan that overlaps another scan.
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SETTING ALARMS

To set alarms, right-click on a display window and then click Alarms from 
the context menu. The Properties dialog box is displayed, with the Alarm 
tab active.

The alarms discussed in this chapter are used by the Configurator 
Software only. They are not the same as the concentration alarms on 
the analyzer. The analyzer concentration alarms operate independent-
ly of the Configurator Software.


NOTE

For Trend and Tabular modes, first select the channel as the source of the 
alarms before you define the alarm values. Setting alarms includes defin-
ing alarm limits and defining the actions that should be taken when an 
alarm limit is reached. Alarm limits also appear on the main display for 
the current mode. High and low limit alarms appear in red; high and low 
warning alarms appear in yellow.

Figure 9-1. 
Alarm properties 
setup screen.
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Enable all alarms

Checked	 Enables all high and low alarms.

Not Checked	 Deactivated – alarms can be deactivated 
when, for example, your system is not 
operating.

High Limit 
When checked, enables the High Limit alarm.

Name	 Enter a name for the alarm that will be used to identify 
the alarm to the system.

Value	 Enter the high (upper) limit value for the alarm.

Count	 Defines the number of consecutive readings that must 
be above the high alarm limit before the alarm is trig-
gered. Higher count values decrease the possibility that 
a transient or noise signal will set off a false alarm.

High Warning 
When checked, enables the High Warning alarm.

Name	 Enter a name for the alarm that will be used to identify 
the alarm to the system.

Value	 Enter the high (upper) limit value for the alarm. Must 
be lower than the high alarm value. 

Count	 Defines the number of consecutive readings that must 
be above the high alarm warning limit before the alarm 
is triggered. Higher count values decrease the possi-
bility that a transient or noise signal will set off a false 
alarm.

Low Limit 
When checked, enables the Low Limit alarm. 

Name	 Enter a name for the alarm that will be used to identify 
the alarm to the system.

Value	 Enter the low limit value for the alarm.

Count	 Defines the number of consecutive readings that must 
be below this limit before the alarm is triggered. Higher 
count values decrease the possibility that a transient or 
noise signal will set off a false alarm.
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Low Warning 
When checked, enables the Low Warning alarm.

Name	 Enter a name for the alarm that will be used to identify 
the alarm to the system.

Value	 Enter the low limit value for the alarm. Must be higher 
than the low alarm value. For analog mode, any mass 
values that fall below this limit are counted even if they 
are from the same scan.

Count	 Defines the number of consecutive readings that must 
be below this limit before the alarm is triggered. Higher 
count values decrease the possibility that a transient or 
noise signal will set off a false alarm.

Auto Set button 
When selected, this button automatically sets the alarm levels as 
follows:

High Limit	 10 times the current scan value.

High Warning	 5 times the current scan value.

Low Warning	 5 times less than the current scan value.

Low Limit	 10 times less than the current scan value.

Action button 
Choose the Action button to view the Alarm Action dialog box, where 
you can specify what action the system should take when the speci-
fied alarm is set.

Figure 9-2. 
Alarm Action dialog 
box.
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Dialog Box 
Specify a message to display when the alarm is set.

Message	 Enter a message that will be displayed in the Alarm 
dialog box when the alarm is set.

Info File	 Enter the name and path of a help file or use the 
Browse button to navigate to the location of a help 
file and select the file.

	 This file will be launched when the user clicks the 
Information button in the Alarm message box that 
appears when an alarm is set. For example, the file 
could suggest what action to take when the alarm is 
triggered.

Sound 
Enter the name and path of a sound file or use the Browse button to 
navigate to the location of the sound files and select a file. This allows 
you to include warning sound (in addition to text instructions) to alert 
the operator when the alarm is set.

Test Dialog button 
Click this button to test the alarm. The Alarm message box will ap-
pear. Click Acknowledge or Disable to close this dialog box. The 
Information button is not currently available.

Figure 9-3. 
Alarm message dialog 
box.
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WORKING WITH DATA FILES

Saving Data Files

Displayed information can be saved for later viewing or printing. 
Each data record within a data file contains scan data from the display 
window(s). Data records are created in serial format, as the data becomes 
available from the system. A Custom mode, for example, will save each 
display as a data record.

1.	 Select the display window or windows for which data will be saved. 

•	 Hold down the Shift key and click on each window to be included 
when selecting multiple display windows. 

•	 Selecting a highlighted display window deselects the display 
window.

•	 If no display window is selected, the software saves data for all 
display windows in the mode.

2.	 Select Save Data from the File menu or click    on the Data File 

Toolbar to view the Save As dialog box. From here, you can specify 

data file attributes.

Figure 10-1. 
Save As dialog box.
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3.	 Once the attributes are set, enter a name for the data file in the File 
name text field and save it in a folder using standard Windows tech-
niques. Select the following:

•	 Save Now radio button 
Prompts the system to save the most recent scanned data and then 
stop scanning. If there are multiple Trend modes within a Custom 
mode setup, only one can be selected for which to save data.

•	 Start Saving radio button 
Prompts the system to start saving data with the next scan and to 
continue saving data files. Activates When File Full command.

•	 When File Full 
Chooses how to handle cases in which the data file becomes 
greater than 1 megabyte. A disk icon appears in the windows that 
are selected to have data saved. Active only when Start Saving is 
active.

	 Stop radio button 
Stops scanning when the file is full.

	 Start new file radio button 
Save the data to a new file. The system automatically appends con-
secutively numbered digits at the end of each new file it creates 
so it is easier to follow the order in which the files were created. 
Each file will be one megabyte in size so the data can be copied to 
a disk.

4.	 To stop saving data, select Stop Saving from the File menu or click 

  on the Data File Toolbar.

Opening Data Files

1.	 Select Open Data from the File menu or click    on the Data File 
Toolbar.

2.	 Navigate to the location of the data file and select it.

3.	 Select Open. The data file appears on the screen. From here it can 
either be viewed or printed.
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Scrolling Through Data Records

Select either Data File Position from the File menu or use the Data File 
Toolbar to scroll forward and backward through the data file using the 
standard recording symbols such as rewind or fast forward.

Converting Data Files

Use this utility to convert the analyzer Configurator Software data files 
into ASCII text.

1.	 Select Convert Data File from the File menu and select one or more 
data files.

2.	 Click Convert to convert and save the file with a CSV extension.

Printing Data

The Configurator Software will print scanning information in a format 
similar to how it is displayed on the screen using the display parameters 
created for that mode. You can view a preview of what will be printed by 
selecting Print Preview from the File menu.

In Custom mode, the system prints the currently selected display win-
dow. If you do not select a display window, the system prints information 
for each display window using the required number of pages.

To print data:

1.	 Select the display window(s) to be printed. If a window is not selected, 
the entire screen will be printed. To select multiple windows, hold 
down the Shift key while selecting each window.

2.	 Select Print from the File menu or click   .

3.	 Type a print-header comment in the Display Print dialog box. This 
information appears in the title of the printed pages. Click OK.

4.	 If you select Print from the File menu, a standard Windows Print dia-
log box appears. Set the additional print information.

5.	 Click OK to print the scanning information.
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DYNAMIC DATA EXCHANGE (DDE)

Copying Magnitudes

You can copy any of the columns from a Tabular display window to the 
clipboard.

1.	 Select Tabular mode.

2.	 Right-click on the mouse and select Copy Magnitudes from the con-
text menu. This places the DDE data onto the clipboard.

3.	 Select Paste Special (or Paste Link, depending on the version of 
Windows running) from the Edit menu to create the DDE link and 
continuously update the data in real time.

Copying Channels

1.	 Select Tabular mode.

2.	 Right-click and select Copy Channels. This places the name of the 
channel onto the clipboard.

3.	 Use Paste Special (or Paste Link, depending on the version of 
Windows running) from the Edit menu to create the DDE link and 
continuously update the channel names in real time.

If you are importing data into Microsoft Excel, select Preference from 
the Edit menu. To place the numbers into separate columns, select 
Return from the DDE Item Separator group. To place the numbers 
in rows, select Tab.


NOTE
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